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TRADEMARK INFORMATION:

Truevision and NuVista+ are registered trademarks of
Truevision, Inc.

NuBus is a registered trademark of Texas Instruments,
Inc.

Apple and Macintosh are registered trademarks of Apple
Computer, Inc.

Finder is a trademark of Apple Computer, Inc.
QuickDraw, 32-Bit QuickDraw, and HyperCard are

trademarks of Apple Computer, Inc.
PhotoShop is a trademark of Adobe, Inc.
Director is a trademark of MacroMedia, Inc.
Multiscan is a registered trademark of Sony Corporation

of America.

General Notice:  Other product names mentioned herein
are used for identification purposes only and may be
trademarks of their respective companies.

TRADEMARKS &

FCC NOTICE

FCC NOTICE:

This equipment has been tested and found to comply with
the limits for a Class A only digital device, pursuant to
Part 15 of the FCC Rules.  These limits are designed to
provide reasonable protection against harmful
interference when the equipment is operated in a
commercial environment.  This equipment generates,
uses, and can radiate radio frequency energy and, if not
installed and used in accordance with the installation
manual, may cause harmful interference to radio
communications.  Operation of this equipment in a
residential area is likely to cause harmful interference in
which case the user will be required to correct the
interference at his own expense.

Any changes or modifications not expressly approved by
Truevision could void the user’s authority to operate this
device.
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If necessary, the user should consult the dealer or
experienced radio/television technician for additional
suggestions.  The user may find the following booklet
prepared by the FCC helpful: “How To Identify and
Resolve Radio-TV Interference Problems.” This booklet
is available from the U.S. Government Printing Office,
Washington, DC 20402,  Stock No. 004-000-00345-4.

LIMITATION OF LIABILITIES:

The reference guide and the enclosed software were
prepared by Truevision, Inc.  While the authors and
program developers have taken reasonable care in
preparing this manual and the files on the enclosed
diskettes to assure their accuracy, the authors assume no
liability resulting from any inaccuracy or omissions
contained in them or from the use of the information or
programs contained herein.

LIMITATION OF LIABILITIES

WARRANTY DISCLAIMER

WARRANTY DISCLAIMER:

The authors and Truevision, Inc. give no expressed or
implied warranty of any kind with regard to these
programs or to the supplemental documentation in this
manual.  In no event shall the authors, the program
developers, or Truevision, Inc. be liable for incidental or
consequential damages in connection with or arising out
of the furnishing, performance, or use of any of these
programs or documentation.  This disclaimer includes, but
is not limited to, any loss of service, loss of business or
anticipatory profits, consequential damages, or personal
injury including death, resulting from the use or operation
of the enclosed software and hardware.
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TRUEVISION® LIMITED

WARRANTY

TRUEVISION® LIMITED WARRANTY:

This limited warranty is given to you by Truevision, Inc.
and extends only to the original customer purchase of
your NuVista+ videographics card.

What the Warranty Covers and How Long

If this product is defective in material or workmanship,
return the NuVista+ card within one year of the original
date of purchase and we will repair or replace it (with  the
same or an equivalent  model), at our option, with no
charge to you.

How to Exercise Your Warranty or Obtain
Service

If you encounter  problems with your NuVista+ card,
contact your dealer or VAR first. They will provide you
with assistance, or obtain an RMA Number from

Truevision for your product. Then you may arrange for
service or for warranty repair by shipping your NuVista+
to:

Truevision, Inc.
7340 Shadeland Station
Indianapolis, IN 46256

There will be no charge for warranty service except
for your prepaid shipping cost to our site. We suggest
that you retain the original packing material in case you
need  to ship your NuVista+ to us. When returning it to
our site, please be sure to include:

Name
Address
Phone Number
Dated Proof of Purchase
RMA Number
Description of the Problem
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TRUEVISION® LIMITED

WARRANTY

We cannot assume responsibility for loss or damage
during shipping. After we repair or replace (at our option)
your NuVista+ card under warranty, it will be shipped
back to you at no cost.

What This Warranty Does Not Cover:

This warranty does not cover damage resulting from
accidents, alteration, failure to follow instructions,
misuse, unauthorized service, fire, flood, acts of God, or
other causes not arising out of defects in material or
workmanship.

What We Will Not Do

We will not pay for loss of time, inconvenience, loss of
use of the product or property damage caused by this
product or its failure to work, or any other incidental or
consequential damages.

This warranty sets forth all our responsibilities regard-
ing this product. Repair or replacement at an autho-
rized service location is your exclusive remedy.

This warranty is the only one we give on this product.
There are no other express or implied warranties
including, but not limited to, merchantability and
fitness for a particular purpose, from Truevision, Inc.

Other Conditions:

If we repair your product, we may use reconditioned
replacement parts or materials. If we choose to replace
your product, we may replace it with a reconditioned one
of the same or equivalent model. Parts used in repairing
or replacing the product will be warranted for one year
from the date that the product is returned. All replaced
products become the property of Truevision, Inc.

State Law Rights:

Some states do not allow limitations on how long an
implied warranty lasts or the exclusion or limitation of
incidental or consequential damages, so the above
exclusions or limitations may not apply to you. This
warranty gives you specific legal rights, and you may
also have other rights which vary from state to state.
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CHAPTER 1

CHAPTER 1 - INTRODUCTION

1.1  Truevision’s NuVista+

The NuVista+ is versatile.  With the NuVista+
you can capture an image in real time from
camera, VCR, or laser disc, and display that
image in 8-, 16-, or 32-bit color.  You can
overlay a captured image or Director animation
on live or taped video, or do the inverse, overlay
video on graphics.  The graphics can be
translucent, blending with the live video
underneath to varying degrees.  Best of all, you
can output any of your creations to tape.

1.1  Truevision’s NuVista+

The NuVista+ is compatible.  The NuVista+
lets you zoom in and out in any Macintosh
application, even the Finder.  You can export
captured images as PICT files to other
Macintosh applications, as well as import PICT
and TGA files created in paint packages.  To
obtain your live video input you can connect
S-Video composite video cameras or VCRs to
the NuVista+, and output in composite video,
S-Video, or RGB.  All you have to do is connect
the video equipment to the NuVista+ and the
rest is software selectable.
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Some Features

There are two versions of the NuVista+ card:
an NTSC version and a PAL version.
Regardless, the NuVista+ is a single-slot card
that functions with any Macintosh II series or
Quadra series computer, and features 3 fully
upgradable memory configurations to suit your
needs and budget.

The NuVista+ allows software selectable input
and output video configurations, including
composite video, S-Video, and RGB.  The
NuVista+ provides robust genlocking circuitry
for automatic synchronization with your video
input and output equipment.  NuVista+ software
utilities make it easy to define custom keys for
overlaying and switching between interlaced
mode for video output or genlocking and
non-interlaced modes.

NuVista+:  Access To The World Of
Color Videographics

Truevision’s NuVista+ transforms your
computer into a powerful visual media system.
The Software Utilities that come with the
NuVista+ make it easy to capture images in real
time and overlay graphics with the touch of a
key.

Truevision VideoScript and VideoMaker+ are
software packages that can be purchased for the
NuVista+.  VideoScript allows you to quickly
create a sequence of video, pictures, and
QuickTime™ movies in a video production.
VideoMAker+, a video switcher, allows you to
combine video and Macintosh graphics that can
be recorded to videotape.

By giving you access to the world of color
videographics, the NuVista+ lets you capture
the reality inside your imagination.

1.1  Truevision’s NuVista+
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1. 2  Overview:  NuVista+ User’s Guide

For your convenience, a quick outline of the
User’s Guide is provided here.

Chapter 1 introduces you to the the world of
videographics and the NuVista+, discusses the
organization of this Guide, installation, and
gets you up and running in a short time.

Chapter 2 provides two Tutorials that explore
the capabilities of the NuVista+ card.  You will
be probing NuVista+’s real-time Capture utility,
overlaying graphics on live video, and saving
animation with video overlay out to tape.  In
addition, suggestions for achieving professional
Chroma Keying results are included.

Chapter 3 describes in detail the five
NuVista+ Control Panel Devices.

Chapter 4 describes NuVista+ Capture.  Some
information about HyperCard XCMDs and
Director XOBJs is given.

Appendix A contains common questions and
their answers regarding video in general,
monitors, and software.  If you are a first time
NuVista+ user, you may find this Appendix
helpful.

Appendix B describes the procedure to
configure your NuVista+ to accomodate other
monitor screen resolutions and scanning modes.
It is intended for the advanced user going
beyond the default driver implementation.

1. 2  Overview
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Appendix C furnishes various possible video
configurations.

Appendix D lists the hardware specifications
for the NuVista+.

A Glossary and Index round out this Guide.

1.3  Conventions Used In This Guide

Two special icons are used in this Guide to
draw your attention.

A question mark indicates a section where
you may have had trouble obtaining the
desired results.  Several items are listed to

help you locate and correct the problem.

A pair of glasses indicates an important
point that you should be sure to read.

?

1.3  Conventions
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1.4  Installation

Before installing your NuVista+ (NTSC or PAL
version) Videographics card, make sure you
have the following equipment available:

• Apple Macintosh II series or Quadra series
computer, with a minimum of 2Mb RAM.

• 40Mb or greater hard drive (recommended).
• System software version 6.0.5 or greater

(recommended).  Note:  The NuVista+ will
boot up and function with any system
version.  However, to use the accompanying
software, it is recommended that you have
version 6.0.5 or later.

• Source of video input (recommended).
Typically a video camera, VCR, or laser disc
player, the source of video input can be
NTSC or PAL  composite video (depending
on card type), S-Video, or RGB.

• 1 or more video output devices. Typically a
monitor or VCR, the video output device can
be composite video, S-Video, or RGB. It is
recommended that you have an analog RGB
multi-scan rate monitor with horizontal scan
rates between 15 and 35 KHz, and vertical
scan rates between 25 and 100 Hz.
Although an Apple RGB Color monitor can
be used with the NuVista+, it is a fixed-rate
monitor and thus will not allow you to use
the NuVista+ to its full capacity (e.g., live
video is not accessible).

• Appropriate input and output cables.
• Phillips screwdriver.

Note:  Due to the limited power supply of the single-slot
Macintosh, we cannot recommend the single-slot Macintosh for

the NuVista+.

1.4  Installation
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NUBUS 
CONNECTOR

VIDEO
OUT

VIDEO
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S-VIDEO/
HV SYNC 
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METAL 
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PIN INSERT

Important Parts On The NuVista+ Card

1.4  Installation
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Turn Off Computer & Remove Cover

1. Turn off your computer.

2. Remove the computer cover. If necessary,
follow the directions that came with your
computer in order to remove the cover.

1.4  Installation

Step 1
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Set S-Video/HV Sync Switch

1. Touch the power supply to discharge any
static electricity.

2. Look for the switch (SW2) mounted on the
circuit board between the two connectors.
The default setting of the switch is UP, for S-
Video.

Leave the switch UP unless your RGB
monitor specifically requires separate hori-
zontal and vertical sync signals.

Note:  The Apple RGB Color monitor, when used with
Truevision's cable CA-5, requires HVSync. ( Set the switch
DOWN.)

1.4  Installation

Step 2
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Prepare Expansion Slot

1. Choose any available expansion slot for the
NuVista+.  If necessary, remove the slot
cover.

CAUTION

Do not use Slot “A” (farthest from power supply) in a
900 or 950 series Quadra computer.  These computers
have a metal protrusion that can damage your
NuVista+, and may damage your computer, if the
NuVista+ is forced into this slot.

Step 3

1.4  Installation
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Insert The card

1. Touch the power supply again to discharge
any static electricity.

2. Carefully holding the card by the edges,
lower the card into the slot.

3. Using both thumbs, press down firmly until
the card fully seats into the expansion slot. If
excessive resistance is present, do not force
the card into the slot.  Simply start over and
try again.

Step 4

1.4  Installation
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Replace The Cover

1. Replace the cover on your Macintosh.  If
necessary, follow the directions that came
with your computer in order to remove the
cover.

Step 4

1.4  Installation
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About Connector Types

The drawing to the right illustrates the types of
connectors you are likely to encounter when
connecting video input and output equipment to
the NuVista+.

A 9-pin D-type male connector will be on one
end of both the Video In and Video Out cables,
but the other end of each cable may be any
connector or combination of connectors pictured
here.

1.4  Installation
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Determining The Correct Output Cable

NuVista+ Video Out requires one end of the
cable to be a 9-pin D-type male, while the
connector on the other end is determined by the
type of connector required for your output
device.

— If you have an RGB device such as a
multi-scan rate monitor, you will need either
another 9-pin D-type connector or 4 BNC
connectors (1 each for Red, Green, Blue, and
composite sync) on the other end of your
output cable.

— If you have an S-Video device such as an
S-Video VCR, you will need a 4-pin DIN
connector on the other end of your output
cable.  (The S-Video/HV Sync switch set in
Step 2 must be UP.  Note: it is not possible to
obtain both S-Video output and HV Sync
simultaneously.)

— If you have a Composite Video device
such as a VCR, you will need an RCA/Phono
connector or a BNC connector with an RCA
adaptor on the other end of your output cable.

See Appendix E of this Guide for a list of
cables available from your Truevision Reseller.

1.4  Installation
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Connecting NuVista+ video Out

1. Using the cable appropriate for your
configuration, connect the NuVista+ Video
Out to the Video In on the device that is to
receive NuVista+ output. This device is
typically a monitor or VCR, and can be
Composite Video, S-Video, or RGB.

It is also possible to simultaneously connect
one device of each type (RGB, S-Video,
Composite Video) to the NuVista+ Video
Out, provided you have a branching cable
with the appropriate connectors.

See Appendix C of this Guide if
circumstances require more than one device of
the same type be connected to the NuVista+.

1.4  Installation
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Determining The Correct Input Cable

If you are not connecting a source of video input
at this time, you may skip this step.

While NuVista+ Video In requires a 9-pin
D-type male connector at one end of the cable,
the connector at the other end of the cable is
determined by the type of connector for Video
Out on your input device.

— If you have an RGB device such as an
RGB camera, you will need either another
9-pin D-type connector or 4 BNC connectors
(1 each for Red, Green, Blue, and composite
sync) on the other end of your input cable.

Note:  If you are using an RGB camera and wish to obtain
Composite or  S-Video output from the NuVista+, then both
the camera's RGB as well as its Composite or S-Video

outputs should be connected to NuVista+Video In. The
Composite or S-Video signal will provide the NuVista+ with
a subcarrier source needed to output Composite or S-Video
with an RGB input. Many cameras already output both RGB
and Composite Video on the same connector.  (Check your
camera's owner's manual to be sure.) However, if your
camera outputs RGB separately from Composite or S-Video,
then you will  need a branching cable (CA-6) in order to
connect both to the NuVista+.

— If you have an S-Video device such as an
S-Video VCR or camera, you will need a 4-
pin DIN connector on the other end of your
input cable.

— If you have a Composite Video device
such as a VCR or laser disc player, you will
need an RCA/Phono connector or a BNC
connector with an RCA adaptor on the other
end of your input cable.

1.4  Installation
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Connecting NuVista+ Video In

1.  Using the cable appropriate for your
configuration, connect the Video Out of your
source device to the NuVista+ Video In.
This device is typically a camera, VCR, or
laser disc player, and can be either
Composite Video, S-Video, or RGB.

Although three input devices of different
types may be connected to NuVista+ Video
In with a branching cable, only one is used at
a time for video input.

See Appendix C of this Guide for examples
of typical video configurations.

1.4  Installation
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Up And Running

1.  Turn on your computer.

2.  Install the NuVista+ software.  Refer to
“1.5 Getting Started” in this chapter.

1.4  Installation
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1.5  Getting Started

In this section you will install the five NuVista+
Control Panel Devices, and three NuVista+
Software Utilities.  The Monitors Control Panel
Device is used to determine which monitor is
associated with the NuVista+.

Installing the NuVista+ Control Panel
Devices

1.  Start up your Macintosh.

2.  Insert the disk labeled “NuVista+ Software.”

3.  Double click (open) the icon titled
“NuVista+ Software.”  You will be

prompted for a location where the software is
to create a new folder for the NuVist+ files.
Specify the location.

4.  Open the newly created folder.  Then open
the “CDEV” folder that is within the newly
created folder.  Drag the icons for NuVista+
CloseUp, MasterKeys, Chroma Keyer,
Blender, and the VIDI/O Control Panel onto
your System Folder.  Make sure you close
the System Folder.

5.  Eject the disk “NuVista+ Software.”

6.  Insert the disk titled “Video Production
Examples,”  and then double click on the
icon “Video Production Examples.”

1.5  Getting Started
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7.  You will be prompted for a location where
the software is to create a new folder for the
video production example (MacroMedia
Director) files.  Specify the location.

8.  Eject the disk “Video Production Examples.”

9.  Verify that you have either System software
version 6.0.5 (or higher) and 32-bit
QuickDraw version 1.2 (or higher), or
System 7.0 in the System Folder on your
startup disk.  To check the system’s version
number, select About the Finder... from the
Apple menu.  If you do not have the correct
version, contact your local Apple dealer for
information.

10.  Restart your Macintosh.

Using Apple’s Monitors Control Panel
Device

For the remainder of this Guide, it will be
assumed that you have your system configured
with one multi-scan rate monitor associated with
your NuVista+ card as well as another monitor
to be used as the main screen.  The NuVista+ is
often used with a one-monitor configuration,
however.  If any differences are apparent when
using NuVista+ software, these will be noted in
this Guide.

Consult the section on Monitors in your
Macintosh owner's manual.  Apple’s Monitors
Control Panel Device enables you to determine
which monitor is associated with which card,
indicate the relative positions of the monitors,
and set the color resolution for all monitors.

1.5  Getting Started
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CHAPTER 2 - TUTORIALS

2.1  Introduction

The Tutorials in this chapter introduce you to
the basic functions of the NuVista+ and take
you step by step through some tasks commonly
performed with the NuVista+.  You will learn
how to capture a live image in real time.  Titles
and animated graphics can be easily overlayed
on live video, and the live video will be blended
with the graphics to various degrees.  Lastly,
instructions for obtaining professional results in
Chroma Keying are included. 2.1  Introduction

Equipment

You will need the following equipment to
complete the first two tutorials:

1.  A NuVista+ card installed in a Macintosh II
series computer.  Consult Chapter 1.4 in
this guide for instructions.

2.  A multi-scan rate monitor.  Because the
Apple RGB Color Monitor was not designed
for interlaced displays, it will not be
compatible with live video images from a
camera, VCR, or laser disc player.

3.  A source of video input, such as a video
camera, VCR, or laser disc player.
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4.  A VCR to save your creations to video tape.
The output VCR cannot also function as an
input VCR;  they must be two separate
machines.

5.  A means of displaying the VCR output.

6.  A video tape to save your output.

7.  Branching cable CA-6 or CA-7 to connect
NuVista+ Video Out to both the monitor and
the VCR.

Software:

1.  NuVista+ Utilities.  Consult Chapter 1.5
of this Guide for installation procedures.

2.  Adobe PhotoShop version 1.0.7 or higher.

3.  MacroMedia Director version 2.0 or higher.

2.1  Introduction
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2.2  The Beginning User

This Tutorial will introduce you to the basic
functionality of the NuVista+, particularly
NuVista+ CloseUp, and NuVista+ Capture,
including Capture’s Overlay capabilities.

If you haven’t done so already, start up your
Macintosh and install the NuVista+ Software.
Consult Chapter 1.5 of this Guide for
software  installation procedures.

Set Your Monitor’s Color Resolution

Select Control Panel from the Apple menu and
click on the Monitors icon.  Set the color
resolution for the NuVista+ screen to Millions

2.2  The Beginning User

of colors.  If you have a 1Mb NuVista+, set the
color resolution to Thousands of colors.
Although you won’t be able to do 32-bit
Overlay in Capture, you will be able to do
Overlay and Blending in the Blender.  Don’t
close the Control Panel yet.
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Use VIDI/O to Select the Type of Video

Verify that your source of video input is
connected and the power turned ON.  You will
not see live video right away.  That will be
accomplished later in the Tutorial.  For purposes
of this Tutorial, it would be best if your source
of live video produced images of an object in
the foreground with a background of a solid or
nearly solid color.

Click on the VIDI/O icon in the left-hand
column of the Control Panel window.  You will
see three buttons used to choose the type of
video input, and four sliders for making
adjustments to the output of the NuVista+.
Don’t bother adjusting the sliders right now.

Select the button that matches the type of video
input to the NuVista+.  If your source of video
input is a VCR or video camera, you should
probably select the button labelled “VIDEO,”
for Composite Video. If your input source is an
RGB camera, select the button labelled “RGB.”
Similarly, if your input source is an S-Video
camera or VCR, select the button labelled
“S-Video.”  Close the Control Panel.

If you are using a VCR or laser disc player as
your source of video input, go ahead and start it
playing now.

2.2  The Beginning User
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NuVista+ Capture

With Capture you can “grab” a frame of video
in real time from your source of live video,
whether it be a camera, VCR, or laser disc
player.

Launch Capture by opening your NuVista+
folder and double-clicking on the Capture icon.
An empty window called the Capture Window
appears, which will later contain the captured
image.  Drag the Capture Window to your
NuVista+ screen.

This tutorial assumes that you are using two
monitors, and that the monitor connected to the
NuVista+ is a multi-scan monitor.

2.2  The Beginning User
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 Select Preferences... from the Special menu.
Click the radio button next to "millions" (32-bit)
if you have a 4Mb NuVista+, or the radio button
next to "thousands" (16-bit) if you have a 1Mb
or 2Mb NuVista+.

If you are using a multi-scan monitor, disable
the "Use Live Time-out during Capture"
selection.

Click OK.

Select Capture Image from the File menu.  The
NuVista+ will automatically switch into
Interlaced mode and you should see live video
occupying the entire NuVista+ screen.  If you
are using a camera for your video input, point it
at the object in the foreground and focus.  If you
are using a VCR or laser disc player, locate a
minute or two of video containing an object in
the foreground and a solid color (or nearly so)
background.

2.2  The Beginning User
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Trouble?  If the NuVista+ screen is black,
click the mouse once (to finish the

Capture command) and then make sure:

• your source of video input is correctly
connected to the NuVista+ Video In
connector (the upper 9-pin connector).

• you have a multi-scan rate monitor
correctly connected to the NuVista+ Video
Out connector (the lower 9-pin connector).

• the type of video selected in the VIDI/O
Control Panel matches the type of video
output coming from your video source.

Now select Capture Image from the File menu
again.

? You will not be able to see a cursor on the
NuVista+ screen.  Click the mouse at the
moment you want to grab a frame of video.
After a moment the image will be displayed in
the Capture Window.

2.2  The Beginning User
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If you have a 1Mb or 2Mb NuVista+, select
Convert to 32-bit Image from the Special menu.
Click NO in the dialog box that asks if you want
to save the Capture Window before converting.

Later we will save this image and use it in
Adobe’s PhotoShop.

2.2  The Beginning User
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Zooming

NuVista+’s Zoom In and Zoom Out keys allow
you to magnify and de-magnify any image on
the NuVista+ screen, such as a captured image,
a PICT in PhotoShop, even the desktop.  Place
the cursor someplace on the image in the
Capture Window.  Now press the Command and
Keypad + keys together.  The Zoom In key
(default is Command-Keypad +) magnifies the
image by two times the current size each time it
is pressed.  An image can be magnified up to
16x its original size.

Keypad   ++Command                 

Zoom In

2.2  The Beginning User
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The Zoom Out key (default is Command-
Keypad -) does just the opposite.  It de-
magnifies the image by one step on the scale of
16x, 8x, 4x, 2x, 1x each time it is pressed.

Practice using the Zoom In and Out keys on
your captured image.  Note that the current
location of the cursor is the central point of
magnification.

Suppose you want to quickly toggle between a
level of magnification and the original size of
the image.  The Zoom Toggle key allows you to
do just that.  Magnify the image using the Zoom
In key.  Now press the Zoom Toggle key
(default Command-Keypad *) several times.
The size of the image will alternate between 1x
and the last level of magnification.

Keypad   -+Command                 

Keypad   *+Command                 

Zoom Out

Zoom Toggle 2.2  The Beginning User
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Panning

To pan, or see another portion of a magnified
image, simply move the cursor in the direction
of the desired portion, and the image will be
scrolled in that direction.

Zoom in on the image using the Zoom In key.
Move your cursor off one of the edges of the
NuVista+ screen.  The image will pan in the
direction of your cursor.  When you are done,
de-magnify the image to its actual size.

Selecting the Key Color

The Key Color is the color of the pixels where
you wish video to show through the image in
the Capture Window.  This color is selected in
anticipation of overlaying video on the image.

2.2  The Beginning User
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Select Choose Key Color... from the Alpha
menu.  A window titled Key Color will appear,
with a black color circle on the left that will
soon indicate the color(s) that you have chosen.
On the right is a column showing the levels of
red, green, blue, hue, saturation, and brightness
for the pixel currently under the cursor.  Below
the color circle is a brightness indicator bar.

Trouble?  If the Choose Key Color menu
item is dimmed, make sure:

• that neither Fit Image to Window nor Fit
Window to Screen in the Special menu is
selected.

?
2.2  The Beginning User
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Move the cursor about the image in the Capture
Window.  The color in the color circle will
match the color of the pixel currently under the
cursor (if the Key Color window is on a color
monitor).  Bring the cursor to rest on a pixel in
the background of your captured image and
click mouse, or click and drag a rectangle with
the mouse over a range of colors.  Now click the
mouse once.

If you’d like, choose a second key color or
range of key colors and then click the mouse
once.

When you are done, close the Key Color
window by clicking in its close box.

2.2  The Beginning User
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Save Your Image

Select Save... from the File menu to save the
image.  You’ll be asked to provide a filename,
so type “Tutorial 1 PICT” in the text box.  Click
SAVE.

The pixels in the image that match the key color
have a special “tag” on them, indicating that
they are able to show live video.  This tag is
called the Alpha channel, and is now saved with
the image.  We will be utilizing the Alpha
channel when we import the image to
PhotoShop. 2.2  The Beginning User
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The Alpha Channel

The Alpha channel can be used to specify any
aspect of a pixel other than its color.  For
example, some Macintosh applications may
make use of an image’s Alpha channel to
specify which pixels are used as a mask or a
filter.

In a 32-bit color image, the color of each pixel
is specified by some mixture of red, green, and
blue.  In each pixel, eight bits are used to
specify the amount of red, eight for the amount
of green, and eight for blue, using a total of 24
bits.  The remaining eight bits are called the
Alpha channel.

In Capture, the Alpha channel serves two
purposes.  First, the Alpha channel specifies
whether or not a pixel displays live video or
whether it displays the desktop image.
Displaying video in certain pixels of an image is
called Overlay.

Second, once the Alpha channel is set, the
image may be saved with the Alpha channel
information and exported to other Macintosh
applications, including those that use the Alpha
channel.

2.2  The Beginning User
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Overlaying Video

Now that the Key Color(s) has been selected,
it’s time to actually overlay the video.  Your
source of video should still be connected and
turned ON.

If you have a 1Mb NuVista+, you won’t be able
to do overlay in Capture or PhotoShop, but it
may be helpful to read through the rest of this
Tutorial.  It would be best to quit Capture at this
time.  Don’t worry though, you’ll have plenty of
opportunity to do both overlay and blending in
the next Tutorial.

2.2  The Beginning User
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If you have a 2Mb or 4Mb NuVista+, select
Interlace from the Alpha menu.  The NuVista+
screen will switch into Interlaced mode, evident
by the slight “flicker” of the image in the
Capture Window.

Select 32-Bit Alpha Blend from the Alpha
menu.  You should see live video showing
through the pixels that match the key color(s).

Trouble?  If the 32-Bit Alpha Blend menu
item is dimmed, make sure:

• that the monitor associated with the
NuVista+ is set to Millions of colors.

• that the Convert To 32-Bit Image menu
item in the Special menu is dimmed,
indicating that the image is a 32-bit image.
If it is not dimmed, select the menu item.

2.2  The Beginning User

?
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Select 32-Bit Alpha Blend and Interlaced from
the Alpha menu once more to restore the
NuVista+ screen to its non-interlaced state.
Quit Capture.

Video Overlay in PhotoShop

Launch Adobe PhotoShop (version 1.0.7 or
higher) by double-clicking on its icon.  Select
Open... from the File menu.  Open the file
“Tutorial 1 PICT”  and drag the window to the
NuVista+ screen.

2.2  The Beginning User
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Make sure that there is a checkmark next to
RGB Color in the Mode menu.  If not, select
RGB Color from the Mode menu.

Select Channel and its sub-menu item RGB in
the Mode menu.

Select Video Alpha and its sub-menu item “#4”
from the Mode menu. #4 refers to the fourth
channel or the Alpha channel.  The others are
being used for color:   one for red, one for
green, and one for blue.

Check your source of video input and make sure
it is ON and running at this time.

Press the Interlace MasterKey (default

2.2  The Beginning User
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Command-Keypad =) to place the NuVista+
screen in Interlaced mode.

Now press the AlphaBlend MasterKey (default
Command-Keypad 9).  You should see video
overlay in the Key Color pixels of the image.

Trouble?  If you did not see live video
showing in the image, make sure:

• the type of video selected in the VIDI/O
Control Panel matches your video source.

• the NuVista+ screen is set to Millions of
colors.

• all cables are secure.

Press the Interlace or AlphaBlend MasterKey
again to bring the NuVista+ screen back to its
non-interlaced state.

2.2  The Beginning User

?

Keypad    =+Command                 

Interlace MasterKey

Keypad   9+Command                 

AlphaBlend MasterKey
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To see the locations of the pixels that are tagged
to show live video, select Channel and its sub-
menu item #4 from the Mode menu.

You will see a gray-scale pattern.  Any white
dots that are present are pixels that are tagged to
show video.  Because they are completely white
(i.e. not gray), they show 100% video (i.e. not a
blend of video and image).  The black dots are
pixels tagged to 100% show image.  The gray
dots will show a mixture of image and live
video.  The ratio of image to video depends on
how white the pixels appear in this channel.

2.2  The Beginning User
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If you would like to experiment with live video
in the Alpha channel, use PhotoShop tools to
add white pixels (or anything else you want to
try) in the Channel #4 window.  Then select the
Channel menu item and its sub-menu item RGB
from the Mode menu.  Press the Interlace and
AlphaBlend MasterKeys again to see your
results.

Quit PhotoShop for now and take a break.  In
the next Tutorial we will use MacroMedia
Director to do title overlay and fades.

2.2  The Beginning User
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2.3  Using MacroMedia Director with the
NuVista+

Getting Started

This Tutorial assumes you already have your
source of video input connected and turned ON.
If you are using a VCR for video input, it must
be a separate machine than the one being used
for output.  Use the VIDI/O Control Panel as
described above to select the type of video
coming into the NuVista+.  If you are using a
VCR or laser disc player, insert a tape or disc
and start it playing. 2.3  Director & NuVista+

Connect NuVista+ Video Out to a VCR and the
current NuVista+ monitor using a branching
cable.  Insert and rewind a tape to which you
will record your video productions.

Open your NuVista+ folder and double-click on
the folder “Video Production.”  Then double-
click on the file “Video Production” to launch
MacroMedia Director.
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If you have a multiple-monitor configuration,
select Preferences... from the Control menu.

Hold the mouse down on the name of the
current screen.  When the submenu pops up,
select Screen2, or whichever screen is
associated with your NuVista+.

2.3  Director & NuVista+
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Click the button labelled MORE, near the lower
edge of the dialog.  Verify that there is an X in
the box next to “Animate in Background under
MultiFinder.”  If there isn’t, place one there and
click OK.  In the main Preferences dialog, click
OK.

Select the Control Panel from the Apple menu
and choose the Monitors Control Panel.  Set the
NuVista+ screen to have Thousands of colors.
Don’t close the Control Panel yet.

2.3  Director & NuVista+
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Fade in Text From Video

In this section we will fade in an animated title
over live video.

Select the Blender icon. Click on the button
labelled “Select Color” and move the cursor to
the NuVista+ screen.  Notice how the color
currently under the cursor is visible in the
Blender Color Square.  Click the mouse when
the cursor is over a pixel in the background of
the green Director Stage.  You have just chosen
the Key Color.  All the other colors on the
screen are called Not Key Colors. 2.3  Director & NuVista+
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Notice that the background color of the Stage is
no longer black, as it originally was in
MacroMedia’s example.  Because black is a
component of the foreground flags and words,
and later of the twirling camera, using black as a
Key Color would cause video to show through
the foreground objects as well as around them.
Because we only want video around the
animated graphics, the Key Color must not be
present in the graphics themselves.

Click on the button along the bottom edge of the
Blender and drag it all the way to the right.  If
you have your video source properly connected
and running, you should now see live video in
the areas previously occupied by the
background.

2.3  Director & NuVista+
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Click the button labelled “Blend Interval” in the
Blender.  You will see a dialog box with four
slider controls;  the upper two for the Key
Color, and the lower two for the Not Key
Colors.  Since the background is the Key Color
and we want the words “Special Report” and the
two flags in the foreground to fade in, we will
only set the controls for Not Key Colors.

2.3  Director & NuVista+
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Drag the triangle beneath the third slider control
all the way to the right, leaving the other three
untouched.  Type the number 240 in the Interval
Timer Box below the fourth control.

These settings indicate that the fade-in of the
text will start as full video and go to full
graphics over a period of four seconds (240
fields equals 120 frames equals 4 seconds in
NTSC, approx. 5 seconds with PAL equipment).
Click OK to close the dialog box.

2.3  Director & NuVista+
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Make sure the button on the Slider at the bottom
of the Blender is all the way to the right.  (It
should already be in this position.)

Hold down the Option Key and move the Slider
button that appears in place of the other one also
all the way to the right.

Moving both Blend Sliders to the right ensures
that the NuVista+ screen starts off with full live
video in both the Key Color pixels and the Not
Key Color pixels.  Close the Control Panel by
clicking in the Close Box.

2.3  Director & NuVista+

Option                +
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Start your output VCR recording.

Press the Play button on the Director Panel to
start the animated graphics.

Now press the Not Color Interval MasterKey
(default Command-Keypad 8).  The text and
flags of the Director animation gradually fade
in.

This method of fading in text or animated
graphics over video has innumerable
applications, ranging from home movie titles to
professional television productions.  The
NuVista+ makes it easy to accomplish while
maintaining high video quality.

2.3  Director & NuVista+

Start VCR

Not Color Interval MasterKey

Keypad   8+Command                 
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Press the Stop and Rewind buttons on the
Director Panel.  Press the Interlace MasterKey
(default Command-Keypad =) to bring the
NuVista+ screen back to its non-interlaced state.

Stop the VCR recording, rewind your VCR tape
and view the results. Stop VCR

2.3  Director & NuVista+
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Fade Both From Image to Live

In this section we will create a fade-out from a
full screen of Director animation to a full screen
of live video.

Select Control Panel from the Apple menu
again, and choose Blender.  If the Color Square
shows a color different than the background of
the Director Stage, click the button labelled
“Select Color” and click the mouse on the
background color of the Stage on the NuVista+
screen.

2.3  Director & NuVista+



Page 2-34

CHAPTER 2

Click the button labelled “Blend Interval.”

2.3  Director & NuVista+
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Drag the triangle beneath the first and third
slider controls all the way to the left.  Drag the
triangle beneath the second and fourth slider
controls all the way to the right.  Type the
number 240 in both Interval Timer Boxes.

These settings indicate that the fade-out of the
text and background will start as full graphics
and go to full live video over a period of four
seconds (approx. 5 seconds with PAL
equipment).   Click OK to close the dialog box.

2.3  Director & NuVista+
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Drag the Blend Slider along the bottom edge of
the Blender Control Panel all the way to the left.

Hold down the Option Key and drag the slider
that appears in place of the other one all the way
to the left also.

Moving both Blend Sliders to the left ensures
that the NuVista+ screen starts off with full
Director graphics in both the Key Color pixels
and the Not Key Color pixels.

Option                + Blend Slider to left

2.3  Director & NuVista+
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While you are still in the Control Panel, click
the MasterKeys icon in the left-hand column.
Each name in the MasterKeys scroll window is
associated with a particular keystroke.  These
keys are called MasterKeys because they can be
used in any application, even the Finder.

Scroll down until the name “Color Interval” is
visible in the scroll window.  Click the mouse
on the name once to see what keystroke is
associated with it.  By default it will be
Command-Keypad 7.

2.3  Director & NuVista+
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Now click once on the name “Not Color
Interval.”  To change the definition of the Not
Color Interval MasterKey, hold down the
Command key and press the Keypad 7 key.
Now both the Color Interval and Not Color
Interval MasterKeys are defined as the same
keystroke.  When this is the case, one keystroke
will cause both the Blend Intervals we defined
in the Blender to be executed at the same time.
Close the Control Panel by clicking in the Close
Box.

Start your output VCR recording. 2.3  Director & NuVista+
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Press the Play button on the Director Panel to
start the animated graphics.

Now press the Color Interval MasterKey (which
is the same as the Not Color Interval MasterKey
now, Command-Keypad 7).  The text and flags
of the Director animation gradually fade away
to a full screen of live video.

Press the Stop and Rewind buttons on the
Director Panel.  Press the Interlace MasterKey
(default Command-Keypad =) to bring the
NuVista+ screen back to its non-interlaced state.

Stop the VCR recording, rewind your VCR tape
and view the results.

Keypad   7+Command                 

Color Interval MasterKey =
Not Color Interval MasterKey

2.3  Director & NuVista+
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Experiment Yourself

Now it’s your turn.  Experiment with Blend
Intervals to create interesting special effects.
The sliders in the Blend Interval dialog need not
always be set to 100% or 0% live.  They can be
set to some position in between, resulting in a
mixture of image and live video.  While you
experiment, follow these steps:

Determine which pixels you want to designate
as Key Color pixels, and use the Select Color
button to designate them.

Plan the starting condition (how much video)
for both Key Color and Not Key Color pixels.
Indicate that condition in the Blend Interval

dialog by setting the first and third sliders.

Plan the ending condition of the special effect,
and indicate it in the Blend Interval dialog as
well.  Use the second and fourth slider controls.

Plan how long the transition is to last for both
Key Color and Not Key Color pixels.  Indicate
the time span in the Blend Interval dialog by
typing the number of video fields each transition
should last in the Interval Timer Boxes.  The
two values need not be the same.

(NTSC:  The number in the box = 60 * the
duration of the transition in seconds.

PAL:   The number in the box = 50 * the
duration of the transition in seconds.)

2.3  Director & NuVista+
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Use the Blend Sliders in the main Blender
Control Panel to achieve the desired amount of
blend in the Key Color and Not Key Color
pixels  on the NuVista+ screen.  These Sliders
immediately affect the amount of blend on the
NuVista+ screen.

Determine if both transitions need to be invoked
by one keystroke or separate keystrokes.  Define
the Color Interval and Not Color Interval
MasterKeys appropriately.

Wrapping Up

When you are done with this Tutorial, be sure to
set the two Interval MasterKeys back to their

original settings (Command-Keypad 7 for Color
Interval MasterKey and Command-Keypad 8
for Not Color Interval MasterKey).  Quit
Director and take a break.

Congratulations!  You have accomplished a
great deal.  You’ve explored Capture’s basic
functionality, used the CloseUp Keys and
MasterKeys, and investigated the Blender.  The
graphic fades we did in Director can be
accomplished in any Macintosh application.  In
the short time it took to accomplish these
Tutorials, you have already experienced the
versatility of the NuVista+ and what it can do
for you.

2.3  Director & NuVista+
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2.4  The Advanced User:  Chroma
Keying

Conventional chroma keying is the process used
to impose live video over computer generated
graphics.  The video is prepared with a
particular hue as the Key Color.  When the
NuVista+ detects the presence of the Key Color
in the video, it inserts the frame buffer contents
in place of the Key Color.  The NuVista+ uses
pure blue as the Key Color because pure blue is
not often found in naturally occurring objects
and tends to work well over a wide range of
production situations.

Chroma keying is typically seen in television
weather reports, where computer-animated
weather maps are projected behind staff
meteorologists.  The foreground subject of the
process (in this case the meteorologist) is
videotaped in front of a pure blue background.
The NuVista+ receives this video input and
determines which pixels are blue in each frame
of the video.  When a blue pixel is detected, that
live pixel is replaced with a pixel from the
image currently in the frame buffer (in this case
the weather map).

2.4  The Advanced User
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Obtaining Professional Results

Background

It is important that the background used be a flat
surface with a matte finish, with a color as close
as possible to pure blue.  We recommend
Ultimatte™ Blue paint applied to canvas or
plywood.  Do not attempt to use blue paint from
a department store.

Camera

An RGB video camera should be used,
preferably with a manual iris mode.  A
Composite Video camera will work, but the
quality may not be sufficient for some
applications.

Lighting

Proper lighting of the foreground object and
particularly the blue background is also
important in getting professional chroma keying
results.  Even lighting of the blue background
will enable the NuVista+ to correctly identify all
blue areas as blue, thereby eliminating
objectionable “crawling” around the edges of
the foreground subject.

The following diagrams illustrate general
lighting designs for a typical chroma keying
news set. 2.4  The Advanced User



Page 2-44

CHAPTER 2

2.4  The Advanced User
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Steps Involved in Chroma Keying

Prepare your graphics, still image, or animation
in an appropriate Macintosh application.

Prepare set lighting to provide even illumination
of the background.  Place the foreground subject
in front of the background and adjust the manual
iris of the camera so that the background is
intense and subject is well exposed.  Avoid very
dark shadows.

Connect the video source (in most cases an
RGB camera) to the NuVista+ card.  Use the
VIDI/O Control Panel to specify whether the
incoming color signal is encoded as Composite
Video, S-Video, or RGB.  (See section 3.4,
VIDI/O Control Panel.)

Verify that the NuVista+ screen is already in
Interlaced mode.  If it is not, use the Interlace
MasterKey.

Select Control Panel from the Apple menu and
choose ChromaKey from the left-hand column.
Click the radio button next to “Chroma Key.”
The prepared graphics should appear in the blue
areas in the live video.  Use the Show Alpha
radio button to assist in adjusting the gain and
external lighting to achieve the best possible
Chroma Keying.  (See also section 3.5 for more
information on the ChromaKey Control Panel
Device.)

2.4  The Advanced User
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CHAPTER 3 - NuVista+ CONTROL PANEL
DEVICES

This chapter describes in detail the five
NuVista+ Control Panel Devices accompanying
your NuVista+.

3.1  NuVista+ CloseUp

Introduction

NuVista+ CloseUp is a Control Panel Device/
INIT that allows you to take advantage of
NuVista+’s powerful hardware zoom and pan
capabilities.  It offers instantaneous “fat bits” in
virtually any Macintosh II application by

3.1  NuVista+ CloseUp

magnifying the area around the cursor by 2x, 4x,
8x, or 16x.

CloseUp functions in any application running
with the NuVista+, including paint packages,
word processing programs, even the Finder.  In
general, it is an excellent means of easing eye
strain with just a keystroke.
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Zooming and Toggling - Default Settings

NuVista+’s Zoom In and Zoom Out keys allow
you to magnify and de-magnify any image on
the NuVista+ screen, including the desktop.

To zoom in on a specific portion of an image,
move the cursor to the area of interest and press
the Zoom In key (default Command-Keypad +).
The area around the cursor will be magnified by
one step on the scale of 2x, 4x, 8x, 16x each
time the Zoom In key is pressed.

To zoom away from a magnified portion of an
image, press the Zoom Out key (default
Command-Keypad -).  The image will be de-
magnified by one step on the scale of 2x, 4x, 8x,
16x each time the Zoom Out key is pressed.

Zoom Out key

Keypad   ++Command                 

Zoom In key

Keypad   -+Command                 

3.1  NuVista+ CloseUp
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To toggle between the last level of
magnification and 1x or the actual size of the
image, press the Zoom Toggle key (default
Command-Keypad *).  Toggling allows you to
quickly zoom between 1x and another level of
magnification while skipping the levels in
between.

Panning

CloseUp also offers fast panning of images
when the image is magnified.  To pan, or see
another portion of an image, simply move the
cursor in the direction of the desired portion,
and the image will scroll in that direction.  As
with Zoom In and Zoom Out, Panning functions

Keypad   *+Command                 

Zoom Toggle key

in any application running with the NuVista+,
even the Finder, provided the image is
magnified.

3.1  NuVista+ CloseUp
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Removing Cursor from View

To remove the cursor from view over a
magnified image without causing the image to
pan, simply hold down the ESC key while
moving the cursor.  When the ESC key is
released, the image will pan to the current
location of the cursor.

Changing Default Settings

The keystrokes for Zoom In, Zoom Out, and
Zoom Toggle can be customized.  Select
Control Panel from the Apple menu.
Double-click the NuVista+ CloseUp icon.  An
edit box will appear next to each of the three
keys, as well as a gray button to disable
CloseUp.

3.1  NuVista+ CloseUp
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To edit a keystroke, click on the edit box next to
the name of the key to select it, making sure the
gray button shows that CloseUp is enabled.
Type a new keystroke in to the edit box, and
close the Control Panel window.

Your custom keystrokes for Zoom In, Zoom
Out, and Zoom Toggle can be a single key or a
key with a modifier.  Any key of the keyboard
including the numeric keypad and function keys
may be used except TAB and CAPS LOCK.
Characters on the numeric keypad are indicated
by a small rectangle containing six dots.  Valid
modifiers include Command, Shift, Command-
Shift, Command-Option, and Command-Shift-
Option.  Note that the Option key alone may not
be used as a modifier.

Any Key

Command Any Key+

Shift Any Key+

Command Shift+ Any Key+

Command + Option Any Key+

+ +Command Shift Option Any Key+

3.1  NuVista+ CloseUp
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Keep in mind that Command-Keypad /,
Command-Keypad =, Command-

Keypad Clear, Command-ESC,  Command-. ,
Command-Keypad 4, Command-Keypad 5,
Command-Keypad 6, Command-Keypad 7,
Command-Keypad 8, and Command-Keypad 9
are default settings for other NuVista+
functions.

Disabling CloseUp

To temporarily disable NuVista+ CloseUp,
select Control Panel from the Apple menu.
Click the NuVista+ CloseUp icon in the left-
hand column.  Click the gray button labelled
“CloseUp Enabled.”  After clicking it once it
will read “CloseUp Disabled.”  Close the

Control Panel window.  To re-enable CloseUp,
click the gray button once so that it reads
“CloseUp Enabled.”

Removing CloseUp

To remove the CloseUp Control Panel Device
permanently until it is reinstalled, open your
System Folder and drag the CloseUp icon
anywhere outside the folder or into another
folder.

Using Two or More NuVista+ Cards

When two or more NuVista+ cards are installed
in your Macintosh, the CloseUp Keys will only
function on the left-most NuVista+ card.

3.1  NuVista+ CloseUp
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3.2  NuVista+ MasterKeys

Introduction

NuVista+ MasterKeys is a Control Panel
Device/Startup document that offers the ability
to invoke special effects, Overlay, or Interlaced
mode at the touch of a key.  These operations
are each associated with a particular keystroke,
and MasterKeys is the place where these
keystrokes are defined.  Please note that the
MasterKeys window must be closed before
actually using MasterKeys. 3.2  NuVista+ MasterKeys

Keypad   9+Command                 

Keypad    /+Command                 

Keypad    =+Command                 

Keypad CLEAR+Command                 

ESC+Command                 

Keypad   8+Command                 

Keypad   8+Command                 

Keypad   8+Command                 

Keypad   8+Command                 

Keypad   8+Command                 

.

4

5

6

Interlace

Overlay

Restore Display

Home Cursor

Not Color Interval

Black Limit Setup

AlphaBlend

Live/Display

Input Source

Genlock

Keypad   7+Command                 Color Interval
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3.2  NuVista+ MasterKeys

Interlace MasterKey

The Interlace MasterKey (default Command-
Keypad =) toggles between the non-interlaced
display mode of the computer monitor and
either the NTSC or PAL interlaced mode
compatible with your video equipment.  If you
have an NTSC version of the NuVista+, then the
Interlace MasterKey will toggle between non-
interlaced mode and NTSC Interlaced mode.
Similarly, if you have a PAL version of the
NuVista+, the Interlace MasterKey will toggle
between non-interlaced mode and PAL
Interlaced mode.  Because it is the MasterKey
that fosters compatibility with video equipment,
it is typically the most-used of all the
MasterKeys.

Overlay MasterKey

The Overlay MasterKey (default Command-
Keypad /) toggles video ON in the Key Color
pixels only.  In the extreme case where the Key
Color Blend Slider is at 100% video (all the way
to the right), then the Overlay MasterKey
toggles between full video and the display of the
image.  However, when the Key Color Blend
Slider is at say, 60% video, the Overlay
MasterKey toggles between the 60%/40% blend
of video to image and the display of the image.

The Overlay MasterKey is not needed when
using the Blender to select a Key Color or
define Blend Intervals.  It is used primarily
within other applications to activate previously
defined settings.
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Restore Display MasterKey

The Restore Display MasterKey (default
Command-Keypad Clear) brings the NuVista+
screen to its default state.  All NuVista+ Control
Panel settings will also be restored to their
default settings, eliminating your current
settings in the various Control Panels.  The
restore Display MasterKey is used when you
have misconfigured your NuVista+ and need to
Restore the default, manufacturer’s settings for
the various Control Panel Devices.

The Restore Display MasterKey is often useful
when using a one-monitor configuration.

If you prefer a quick way to restore the
NuVista+ screen to its non-interlaced state, set
the definitions for both the Interlace and
Overlay MasterKeys to be the same keystroke
and use that key instead of the Restore Display
MasterKey.  Using this method, you will be able
to retain your current settings of the various
Control Panels, even when the Macintosh is
restarted.

If the video out from the NuVista+
appears to be washed out or monochrome, press
the following key sequence:
         Command-Keypad Clear (twice).

3.2  NuVista+ MasterKeys
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Home Cursor MasterKey

The Home Cursor MasterKey (default
Command-ESC) simply places your cursor in
the upper left corner of the menubar on the main
screen.  This MasterKey is a convenience when
working with multiple monitors.

Color Interval MasterKey

The Color Interval MasterKey (default
Command-Keypad 7) is used to invoke the
Color Interval special effect in any application.
Both the Key Color and the Color Interval must
already be specified in the Blender.  Only the
pixels matching the Key Color are affected by
the transition.

The Color Interval MasterKey is particularly
useful for creating fades and other special
effects used in video production.

3.2  NuVista+ MasterKeys

Not Color Interval MasterKey

The Not Color Interval MasterKey (default
Command-Keypad 8) is used to invoke the Not
Color Interval special effect in any application.
Both the Key Color and the Not Color Interval
must already be specified in the Blender.  Only
the pixels not matching the Key Color are
affected by the transition.

By default, the Color and Not Color Interval
MasterKeys are associated with different
keystrokes.  This need not always be the case.
If both Intervals are assigned to the same
MasterKey, then both the pixels matching the
Key Color and those not matching the Key
Color will be affected in the transition.
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Genlock MasterKey

The Genlock MasterKey (default Command-
Keypad 6) toggles Genlock On/Off.

AlphaBlend MasterKey

The AlphaBlend MasterKey (default Command-
Keypad 9) is used to implement a blend of
image to live video on a pixel-by-pixel basis.
This MasterKey can be used with any
application that allows you to assign values to
the Alpha channel of pixels in an image.  The
Alpha channel is a name for the 8 bits not used
in defining the color of a 32-bit pixel.  In 32-bit
color, 8 bits of each pixel are used for red, 8 for
green, and 8 for blue, leaving 8 for what is

3.2  NuVista+ MasterKeys

Black Limit Setup MasterKey

The Black Limit Setup MasterKey (default
Command-Keypad period) toggles the black
level between 7.5 IRE and 0 (zero) IRE.

Live/Display MasterKey

The Live/Display MasterKey (default
Command-Keypad 4) toggles between live
video and capture mode.

Input Source MasterKey

The Input Source MasterKey (default
Command-Keypad 5) toggles the RGB,
Composite, and S-Video inputs.
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called the Alpha channel.  The Alpha channel
can be used to describe any aspect of a pixel
other than its color.  Some applications use them
for masking or blending, but others do not make
use of the Alpha channel.

Typically, the application will require you to
specify gray-scale values for pixels in an Alpha
channel.  These values are then treated not as
gray-scale, but as levels of video/image blend,
akin to the levels of opacity that can be achieved
using the Blend Slider in the Blender, but on a
single-pixel basis.  When the AlphaBlend
MasterKey is invoked, the white pixels in the
Alpha channel contain 100% live video, while
the black pixels contain 0% live video or 100%
image.  The gray pixels in between contain a

blend of live video and image that corresponds
to the gray-scale value in its Alpha channel.

Consult the documentation of the application
you are using to find out how the Alpha channel
is used.  When you have specified gray-scale
values on the Alpha channel and set the
NuVista+ screen to Interlaced mode, press the
AlphaBlend MasterKey to see live video in the
whiter pixels.

3.2  NuVista+ MasterKeys
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Changing Default Settings

The keystrokes associated with each MasterKey
can be customized.  Select Control Panel from
the Apple menu.  Click the NuVista+
MasterKeys icon in the left-hand column.  Click
on the name of the MasterKey you wish to edit.
You may have to scroll the window a bit to see
all of them.  An edit box will appear below the
list of MasterKeys, as well as a gray button to
disable each.  Type a new keystroke in the edit
box, making sure the gray button indicates the
MasterKey is enabled.  Close the Control Panel
window.

Your custom keystroke for each MasterKey can
be a single key or a key with a modifier.  Any
key of the keyboard including the numeric
keypad may be used except TAB and CAPS
LOCK.  Characters on the numeric keypad are
indicated by a small rectangle containing six
dots.  Valid modifiers include Command, Shift,
Command-Shift, Command-Option, and
Command-Shift-Option.  Note that the Option
key alone may not be used as a modifier.

Keep in mind that Command-Keypad +,
Command-Keypad -, and Command-Keypad *
are default settings for other NuVista+
functions.

3.2  NuVista+ MasterKeys
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Disabling Masterkeys

Each one of the MasterKeys can be disabled
separately.  To temporarily disable one or all of
the MasterKeys, select Control Panel from the
Apple menu.  Click the NuVista+ Masterkeys
icon in the left-hand column.  Select one of the
MasterKeys in the scroll window, and then click
the gray button below it.  After clicking it once
it will read “[MasterKey] Disabled.”  Close the
Control Panel window. To re-enable the
MasterKey, select the MasterKey to be enabled
in the scroll window, and then click the gray
button below it once so that it reads
“[MasterKey] Enabled.”

3.2  NuVista+ MasterKeys
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Removing Masterkeys

To remove the MasterKeys Control Panel
Device permanently until it is reinstalled, open
your System Folder and drag the MasterKeys
icon anywhere outside the folder or into another
folder.

3.2  NuVista+ MasterKeys
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Using Two or More NuVista+ Cards

When two or more NuVista+ cards are installed
in your Macintosh, MasterKeys will access the
left-most NuVista+ card by default.  Therefore,
whenever you press one of the MasterKeys, its
effect will be seen on the screen associated with
the left-most NuVista+ card.

To change the default and indicate which screen
you want the MasterKeys to affect, choose
Control Panel from the Apple menu and select
MasterKeys from the left-hand column.  Click
once on the Truevision logo.  The cursor will
turn into a square “monitor” icon.  Click the
cursor on the screen that you want the
MasterKeys to affect.

3.2  NuVista+ MasterKeys

Monitor Icon
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Overlaying Graphics on Live Video

Suppose you wanted to briefly overlay the name
of a person being interviewed over the live
video of the interview itself.  The NuVista+ was
designed with applications like this in mind.

Prepare the graphics of the person’s name (or
any text, graphics, or animation) using an
appropriate Macintosh application.  (Even the
desktop may be used as a graphic overlay.)  As
you do so, keep in mind where you would like
the live video to show through.  Make those
areas a specific color.  This color will later be
selected as the Key Color.

Connect the video source such as a VCR or
video camera to the NuVista+ Video In and turn

the power ON.  Use the VIDI/O Control Panel
to specify whether the incoming video is
composite video, S-video, or RGB.  (See section
3.4, NuVista+ VIDI/O Control Panel.)

To select the Key Color, choose the Control
Panel from the Apple menu and select the
Blender.  The NuVista+ screen will
automatically switch into Interlaced mode.
Click the button labelled “Select Color.”  Move
your cursor about the NuVista+ screen and click
the mouse on the color of your choice.  Now
adjust the Blend Slider to achieve the desired
blend of video and image.  You should see
video in the Key Color pixels on the NuVista+
screen.  (For more information, see section 3.3,
NuVista+ Blender.)

3.2  NuVista+ MasterKeys
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Trouble?  If the portions of the image
where live video should have been visible
only show black, verify:

• that you have the correct cable for the type
of input source you have, and that all cables
are secure.

•  that the type of video selected in the
VIDI/O Control Panel (Composite, S-Video,
or RGB) matches the type of input source
you have.

• If you are obtaining video input from an
RGB camera, it is possible that you need to
specify a subcarrier source.  See section 3.4,
VIDI/O Control Panel for more information.

3.2  NuVista+ MasterKeys

?
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3.3  NuVista+ Blender

Introduction

The NuVista+ Blender is a Control Panel
Device that allows you to incorporate special
effects into your video productions.  A Key
Color is chosen to indicate in which pixels of
the image to show live video.  Video can be
shown in all the pixels matching the Key Color,
and/or in all the pixels not matching the Key
Color.  The pixels showing video can be
blended with graphics at any one of 256 levels
of opacity. 3.3  NuVista+ Blender

With the Blender you can define a “blend
interval” for fades and dissolves, and these
special effects can be invoked at the touch of a
MasterKey in any application.
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Selecting a Color

To select the Key Color, choose the Control
Panel from the Apple menu and select the
Blender.  The NuVista+ screen will
automatically go into Interlaced mode.  Click
the button labelled “Select Color.”  The button
will look like it has been pushed down.  Now
move your cursor about the NuVista+ screen.
As you do so, the color of the pixel currently
under the mouse will show in the top half of the
colored square.  The bottom half shows the
previous Key Color.  When you click the mouse
on the color of your choice, the entire square
becomes the Key Color and the pixels matching
the Key Color show video.  For your
information, the levels of Red, Green, and Blue
(from 0 to 65535) are indicated to the right.

3.3  NuVista+ Blender
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The Blend Slider for Key Color

Along the bottom edge of the Blender Control
Panel is the Blend Slider.  This slider affects the
degree to which live video is mixed with the
Key Color pixels in the image when the
monitor is set to Thousands or Millions of
Colors or Grays.  To see the result, the
NuVista+ screen should be in Interlaced mode
and Overlay toggled ON.  Use this Blend Slider
whenever you want to change the current
amount of video in Key Color pixels of an
image.

When the Slider is all the way to the right, all
pixels matching the Key Color will show 100%

3.3  NuVista+ Blender



Page 3-22

CHAPTER 3

live video.  The other pixels in the image will
not be affected.

When the Slider is all the way to the left (the
default position), all pixels matching the Key
Color will show 0% live video.  In this case the
Key Color pixels will look normal, as they do
when they are part of the image.

When the Slider is somewhere in between, the
Key Color pixels will show a blend of video and
image when the NuVista+ screen is in Interlaced
mode and Overlay is toggled ON.  The image
will appear “transparent” by allowing some live
video to show through.  The ratio of live video
to image depends on the position of the Slider.
There are 256 possible levels of transparency
available.

Toggling Overlay

Once the Blend Slider for Key Color has been
set, pressing the Overlay MasterKey will toggle
video ON and OFF in the Key Color pixels of
the image.

3.3  NuVista+ Blender
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The Blend Slider for Not Key Color

When the Option Key is pressed, another Blend
Slider appears in place of the first Blend Slider.
This slider affects the degree to which live video
is mixed with the Not Key Color pixels in the
image when the monitor is set to Thousands or
Millions of Colors or Grays.  To see the result,
the NuVista+ screen should be in Interlaced
mode and Overlay toggled ON. Use this Slider
whenever you want to change the current
amount of video in Not Key Color pixels of an
image.

When the Slider is all the way to the left (the
default position), the pixels not matching the

3.3  NuVista+ Blender

Option                +
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Key Color will remain unaffected (showing 0%
live video).  Because the pixels do not match the
Key Color, it is appropriate that they do not
show live video until the Slider is moved.

When the Slider is all the way to the right, all
pixels not matching the Key Color will show
100% live video.  The other pixels in the image
will not be affected.

When the Slider is somewhere in between, the
Not Key Color pixels will show a blend of live
video and frame buffer image when the
NuVista+ screen is in Interlaced mode and
Overlay is toggled ON.  The image will appear
“transparent” by allowing some video to show

through.  The ratio of video to image depends
on the position of the Slider.  There are 256
possible levels of transparency available.

When both sliders are all the way to the right,
the entire NuVista+ screen will show video.
Similarly, when both sliders are all the way to
the left, the entire screen will show the image.

3.3  NuVista+ Blender
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The Blend Interval

The Blend Interval will allow you to create
special effects and transitions with the
NuVista+.  Conceptually, a Blend Interval is a
blend of video and image over a time period.
During this time period the ratio of video to
image gradually changes.  For example, if you
want a fade-out from live video to the Key
Color, first set the Blend Interval and then
invoke the Color Interval MasterKey when you
want to see the special effect.  Alternatively, all
the pixels except the Key Color pixels can be
used in the special effect.  In this case the Not
Color Interval MasterKey is invoked after the
Blend Interval is set.  A fade-in or fade-out at
the touch of a key is a handy feature in video
production.

Setting the Blend Interval

To set the Blend Interval, click the button
labelled “Blend Interval” in the Blender Control
Panel.  A dialog box with four slider controls
will appear, two above and two below.  The
upper two controls are used to set the Blend
Interval for all pixels matching the Key Color.
In this case the Blend Interval is called the
Color Interval and is invoked by the Color
Interval MasterKey.

The lower two sliders are used to set the Blend
Interval for all the pixels that do not match the
Key Color. In this case the Blend Interval is
called the Not Color Interval and is invoked by
the Not Color Interval MasterKey.

3.3  NuVista+ Blender
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Color Interval

The Color Interval is the Blend Interval
associated with the pixels that match the Key
Color.  The pixels not matching the Key Color
are not affected during the transition.

To set the amount of blend for the start of the
transition, drag the triangle beneath the top-most
slider control to the percentage of live video
desired.  If the triangle is at 0% on the first
control, the pixels matching the Key Color will
begin the transition as full image pixels.  If the
triangle is at 100%, the Key Color pixels will
begin the transition as full live video pixels.

3.3  NuVista+ Blender
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To set the amount of blend for the end of the
transition, drag the triangle beneath the second
slider control to the percentage of live video
desired.  As before, if the triangle is at 0% on
the second control, the Key Color pixels will
end the transition as full image pixels.  If the
triangle is at 100%, the Key Color pixels will
end the transition as full live video pixels.

Of course, the triangles for either the beginning
or end of the transition may be set somewhere in
the middle.

Although you will see little change, it is not
necessary for the two triangles to be set to
different numbers.

The Interval Timer

Once the the amount of blend for both the
beginning and end of the transition have been
set, the amount of time taken for the transition
(in video fields) must be specified.

To do this, type a number greater than 0 in the
text box labelled “Interval Timer.”  For those
with NTSC video equipment, which runs at 60
fields/second (30 frames/second), typing the
number 180 in the text box will cause the
transition to last 3 seconds.  PAL equipment
runs at 50 fields/second (25 frames/second), so
typing the number 200 in the text box will
specify a transition lasting 4 seconds.

3.3  NuVista+ Blender
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If there is a 0 in the Interval Timer Box,
the Color Interval transition will not be

executed, even though its beginning and end
blend amounts may be specified.

3.3  NuVista+ Blender
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Previewing the Results

Now you are ready to preview the transition.
Click the button labelled “Preview” to the right
of the upper Interval Timer Box.  The transition
will take place immediately on the NuVista+
screen.

When the Color Interval is specified to your
satisfaction, click OK.  When it comes time to
invoke the transition, press the Interlace
MasterKey and then the Color Interval
MasterKey.  The special effect will immediately
begin. 3.3  NuVista+ Blender
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Trouble?  If you do not see the special
effect specified in the Blend Interval
dialog box, make sure:

• that your source of video input is connected
and turned on, and that its type is correctly
identified in the VIDI/O Control Panel.

• that the NuVista+ screen is set to Thousands
or Millions of colors.

• that you have selected a Key Color in the
Blender.

• that the NuVista+ screen is in Interlaced
mode and that the Overlay MasterKey has
toggled video ON in the Key Color pixels (the
Blender will have done this automatically).

• that you have set the amounts of blend for
the beginning and end of the transition.

• that you have specified a value greater  than
0 in the Key Color Interval Timer Box.

3.3  NuVista+ Blender

? Not Color Interval

The Not Color Interval is the Blend Interval
associated with all the pixels that do not match
the Key Color.  The pixels matching the Key
Color are not affected during the transition.  The
amounts of blend for the beginning and end of
the transition are set the same way as for the
Color Interval (see above).

The Interval Timer

The Interval Timer is set the same way as for
the Color Interval.

If there is a 0 in the Interval Timer Box,
the Not Color Interval transition will

not be executed, even though its beginning and
end blend amounts may be specified.
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Causing both Intervals to Take Place
Simultaneously

By default, the Color and Not Color Intervals
are associated with different MasterKeys.  If this
is not the case, both Intervals can be invoked
with one keystroke.  Instructions for changing
the settings of MasterKeys can be found earlier
in this chapter.

Removing Blender

To remove the Blender Control Panel Device
permanently until it is reinstalled, open your
System Folder and drag the Blender icon

3.3  NuVista+ Blender

Previewing the Results

The Not Color Interval can be previewed by
pressing the button labelled “Preview” next to
the lower Interval Timer Box, as you do for
Color Interval.

When the Not Color Interval is specified to your
satisfaction, click OK.  When it comes time to
invoke the transition, press the Interlace
MasterKey and then the Not Color Interval
MasterKey.  The special effect will immediately
begin.
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anywhere outside the folder or into another
folder.

Using Two or More NuVista+ Cards

When two or more NuVista+ cards are installed
in your Macintosh, the Blender will access the
left-most NuVista+ card by default.  Therefore,
whenever you use the Blender, its effect will be
seen on the screen associated with the left-most
NuVista+ card.

To change the default and indicate which screen
you want the Blender to affect, choose Control
Panel from the Apple menu and select Blender
from the left-hand column.  Click once on the
Truevision logo.  The cursor will turn into a

3.3  NuVista+ Blender

square “monitor” icon.  Click the cursor on the
screen that you want the Blender to affect.
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3.4  NuVista+ VIDI/O Control Panel

Introduction

The NuVista+ VIDI/O Control Panel is a
Control Panel Device that allows you to specify
the type of video input coming to the NuVista+,
and various options and adjustments for both
video input and NuVista+ output.

The Input Selector

The Input Selector allows you to indicate the
type of video input that is being received by the
NuVista+.  The default setting for the Input
Selector is RGB, indicated by the light-colored
label on the RGB button (green if your monitor
is color).

3.4  NuVista+ VIDI/O

Select the button that matches the type of video
input to the NuVista+.  If your source of video
input is a VCR or video camera, you should
probably select the button labelled “VIDEO,”
for Composite Video. If your input source is an
RGB camera, select the button labelled “RGB.”
Similarly, if your input source is an S-Video
camera or VCR, select the button labelled “S-
Video.”

Some video equipment outputs more than one
type of video signal at the same time, such as
RGB as well as Composite Video, or S-Video
and Composite Video.  If this is the case, you
may select either of the two appropriate buttons
in the VIDI/O Control Panel.
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A Note About Subcarrier Source

Most RGB cameras output an RGB as well as a
Composite Video signal on the same connector.
The NuVista+ uses the Composite Video signal
(as do many other video products) as source of
subcarrier information.

However, certain RGB cameras output an RGB
and Composite Video signal on separate
connectors, and/or possibly output an S-Video
signal to be used as a subcarrier source.  Certain
adjustments must be made if this is the case and
you wish to get Composite or S-Video output
from your NuVista+.

If your camera outputs an S-Video signal (either
separately or on the same connector as RGB),

hold down the Option key while you click the
button labelled “RGB” in the VIDI/O Control
Panel.  The button now reads “RGB-SV,”
indicating that an S-Video signal (instead of the
default Composite Video signal) is being used
as a subcarrier source.  When the button is
clicked again, it will read “RGB” again,
indicating that a Composite Video signal is
being used as a subcarrier source.

If your camera outputs a Composite or S-Video
signal on a separate connector than the RGB
signal, you will need a branching cable (CA-6),
having S-Video and Composite Video
connectors as well as RGB connectors.  Connect
the camera to the NuVista+ with both the RGB
connectors and either the Composite or S-Video
connector.

3.4  NuVista+ VIDI/O
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3.4  NuVista+ VIDI/O

Tint

The Tint Slider changes the hue of the image,
only when the source of video input is
Composite Video.

Color

The Color Slider changes the color intensity of
the image, only when the source of video input
is Composite Video.

Brightness

The Brightness Slider affects the amount of
white in the entire image.

Decoder Options

The Decoder options allow adjustments to the
video input to the NuVista+.  These controls
affect the live video in the same way as they do
on your television set.

To use the decoder options most effectively,
choose Control Panel from the Apple menu and
select General from the left-hand column.  Set
your desktop pattern to be a solid color.  Use the
Blender to select this color as the Key Color.
When video appears on your desktop, select
VIDI/O from the left-hand column and adjust
the decoder options to your liking.
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Contrast

The Contrast Slider affects the amount of
difference between the light and dark areas in
the image.

Encoder Options

The Encoder options allow adjustments to the
output of the NuVista+, particularly horizontal
phase and subcarrier phase adjustments.  Most
users will not need to use these adjustments;
they are mainly intended for broadcast engineers
in studio situations.

Click once on the button labelled Decoder
Options.  It should now read Encoder Options.

3.4  NuVista+ VIDI/O
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Subcarrier Phase Invert

The Subcarrier Phase Invert is the coarse
Subcarrier Phase adjustment.  Clicking on the
button labelled “180°” causes the subcarrier
phase to be shifted 180°.

Subcarrier Phase Adjust

The Subcarrier Phase Adjustment Slider adjusts
the subcarrier phase in increments of 3°.

Horizontal Phase Adjustment

The Horizontal Phase Adjustment Slider allows
you to adjust the horizontal phase in studio
situations where cable compensation is needed.

Removing VIDI/O Control Panel

To remove the VIDI/O Control Panel Device
permanently until it is reinstalled, open your
System Folder and drag the VIDI/O icon
anywhere outside the folder or into another
folder.

Using Two or More NuVista+ Cards

When two or more NuVista+ cards are installed
in your Macintosh, the VIDI/O Control Panel
will access the left-most NuVista+ card by
default.  Therefore, whenever you use the
VIDI/O Control Panel, its effects will be seen
on the screen associated with the left-most
NuVista+ card.

3.4  NuVista+ VIDI/O
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To change the default and indicate which screen
you want the VIDI/O Control Panel to affect,
choose Control Panel from the Apple menu and
select VIDI/O from the left-hand column.  Click
once on the Truevision logo.  The cursor will
turn into a square “monitor” icon.  Click the
cursor on the screen that you want the VIDI/O
Control Panel to affect.

3.5  NuVista+ Chroma Key

Introduction

The NuVista+ Chroma Keyer is a Control Panel
Device that allows you to achieve professional
Chroma Keying results.  Television news
stations perform Chroma Keying every time
they superimpose the live video image of a
weatherperson over a still or animated weather
map.  The video is prepared with a pure blue
color in places where the map is intended to be
visible.  The NuVista+ performs Chroma
Keying by “keying” on the blue pixels it can
find in the incoming live video.  When the
Chroma Keyer is invoked, those pixels will
show frame buffer image.

3.5  NuVista+ Chroma Key
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To access the Chroma Keyer, select Control
Panel from the Apple menu and click on the
Chroma Keyer’s icon in the left-hand column.
The Chroma Key window has three display
radio buttons on the right, three gain settings on
the left, and a slider below for setting the zero
level.

The Display Radio Buttons

The three display radio buttons on the right of
the Chroma Key window allow you to switch
between normal display, Chroma Key or a
display of live plus the image, and Alpha
display.  Each setting is described below.

3.5  NuVista+ Chroma Key
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Normal Display

The default display setting is Normal Display,
as would be expected.  Whether the NuVista+
screen is in Interlaced mode or not, Normal
Display shows the graphic or image on the
screen at the time.  No video is present.

Chroma Key

Clicking the Chroma Key radio button will set
the NuVista+ screen in Interlaced mode and
invoke the Chroma Keyer.  Assuming the
incoming video signal includes some portions
that are pure blue (or as close as possible), the
screen will show the graphics on the NuVista+
screen in all areas that were blue in the video
signal.

Show Alpha

Clicking the Show Alpha radio button shows the
incoming video signal as a black and white
picture.  This picture is not merely a negative,
but indicates which pixels the NuVista+ has
determined to be blue by showing them as
black.  By providing a sharp contrast between
blue pixels and non-blue pixels, this
representation aids you in adjusting the external
lighting, the Gain radio buttons, and the slider
control to get the best Chroma Keying results.

Remove Excess Blue

Remove Excess Blue should be checked if the
video appears to have blue borders.

3.5  NuVista+ Chroma Key
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Gain

The Gain radio buttons and the slider control
below allow you to adjust the Chroma Key
signal to obtain the best possible Chroma
Keying results.  These adjustments are often
made with the Show Alpha radio button clicked.
Experiment with these settings to achieve the
sharpest contrast between black and white in the
Show Alpha window.

Overlaying Live Video on Graphics

Suppose you wanted to impose a live video of a
weatherperson over a picture of a weather map.
Because it will be impossible to predict where

the weatherperson will be standing, a Key Color
as described above cannot be incorporated into
the prepared graphic.  Instead, the live video is
prepared with the graphic “underlay” in mind.
Because pure blue appears rarely in naturally
occurring objects, the live video is prepared
with areas where the graphics should appear as
close as possible to pure blue.  The blue color,
known as the Chroma Key Color, will be
replaced by the graphics when the two are
combined.

Prepare set lighting to provide even illumination
of background and foreground.  The following
diagrams illustrate general lighting designs for a
typical chroma keying news set.

3.5  NuVista+ Chroma Key
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Prepare your graphics, still image, or animation
in an appropriate Macintosh application.
Prepare the video to have a rich blue color (with
as little red and green as possible) where you
want the graphics to show through.

Connect the video source such as a VCR or
video camera to the NuVista+ card.  Use the
VIDI/O Control Panel to specify whether the
incoming color signal is encoded as composite
video, S-video, or RGB.  (See section 3.4,
VIDI/O Control Panel.)

Verify that the NuVista+ screen is already in
Interlaced mode.  If it is not, use the Interlace
MasterKey.

Select Control Panel from the Apple menu and
choose Chroma Key from the left-hand column.
Click the radio button next to “Chroma Key.”
The prepared graphics should appear in the blue
areas in the live video.  Use the Show Alpha
radio button to assist in adjusting the gain and
external lighting to achieve the best possible
Chroma Keying.

Removing Chroma Key

To remove the Chroma Key Control Panel
Device permanently until it is reinstalled, open
your System Folder and drag the Chroma Key
icon anywhere outside the folder or into another
folder.

3.5  NuVista+ Chroma Key
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Using Two or More NuVista+ Cards

When two or more NuVista+ cards are installed
in your Macintosh, The Chroma Keyer will
access the left-most NuVista+ card by default.
Therefore, whenever you use the Chroma
Keyer, its effect will be seen on the screen
associated with the left-most NuVista+ card.

To change the default and indicate which screen
you want the Chroma Keyer to affect, choose
Control Panel from the Apple menu and select
Chroma Key from the left-hand column.  Click
once on the Truevision logo.  The cursor will
turn into a square “monitor” icon.  Click the
cursor on the screen that you want the Chroma
Keyer to affect.

3.5  NuVista+ Chroma Key
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CHAPTER 4 - NuVista+ SOFTWARE

4.1  NuVista+ Capture

Introduction

NuVista+ Capture is an application that allows
you to “take a snapshot” or capture a frame of a
live video in real time. You can choose one or
more Key Colors for live video overlay and save
the Alpha channels (video overlay information)
of these pixels. This image, including the Alpha
channel information, can then be saved whole or
in part and exported to other Macintosh
applications.

4.1  NuVista+ Capture

With Capture you can import any PICT or 32-
bit TGA file, convert a PICT file to a 32-bit
TGA file and vice versa, and convert any image
to 32, 16, or 8 bits per pixel.

The memory requirements of Capture can be
reduced to 512K, provided that sufficient
memory is available on the NuVista+ card.
(Note:  At the 512K level, some Capture
features may take longer to perform.)

To use Capture you will need to connect a
source of video input such as a camera, VCR, or
laser disc player to NuVista+ Video In.  Use the
VIDI/O Control Panel to specify whether the
video input is Composite Video, S-Video, or
RGB.  (See also section 3.4, VIDI/O Control
Panel.)
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Capturing an Image

To capture an image in real time, launch
Capture by double-clicking on its icon.  An
empty window titled the Capture Window will
appear, with the current image size (in pixels)
and video input source mode (NTSC or PAL) in
the title bar.  If necessary, move the Capture
window to the NuVista+ monitor.

Select Capture Image from the File menu.  The
NuVista+ screen will automatically switch into
Interlaced mode and a live picture coming from
the input source will fill the entire screen.  Click
the mouse when you are ready to capture a
frame.  It is not necessary for live video to be
stationary.

4.1  NuVista+ Capture
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Although the captured image will have 16-bit
color resolution by default, it may appear in the
Capture Window with a different color
resolution, depending on the current setting of
the screen in the Monitors Control Panel
Device.  Although the display resolution of the
captured image is affected by the Monitors
settings, the color resolution at which the image
is saved is not.

Dithering

Selecting Use Dithering from the Special menu
may improve the 8-bit display quality of a 32-
or 16-bit image by providing error diffusion.

4.1  NuVista+ Capture
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Resizing an Image

Fit Image to Window

Selecting Fit Image to Window in the Special
menu will cause the image to be resized to fit
exactly in the Capture Window.  Neither the
gray scroll bars nor a white border around the
image will be present.  The proportions of the
image may be distorted.  As long as this toggle
menu item is selected (there is a check mark
next to it in the Special menu), the image will be
resized to fit the window every time the size of
the window is changed.

To maintain the proper proportions of the image
while Fit Image to Window is checked, hold
down the Option key while you are resizing the
window.

In order to select Choose Key Color...
from the Alpha menu, this menu item

must not be checked.

4.1  NuVista+ Capture
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Fit Window to Screen

Selecting Fit Window to Screen in the Special
menu will cause the borders of the Capture
Window to disappear.  This menu item is
particularly useful when overlaying your image
on live video.  If the NuVista+ screen is the
main screen, the menubar can be removed by
pressing Command-Space if the NuVista+
screen is the main screen.

If both Fit Image to Window and Fit Window to
Screen are selected, the image will be expanded
(possibly disproportionately) to fill the entire
screen.

In order to select Choose Key Color...
from the Alpha menu, this menu item

must not be checked.

Command Space Bar+
4.1  NuVista+ Capture
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A Note About Color Resolution

Because the NuVista+ is a videographics card,
color resolution is an important topic to users of
all types.  In Capture, there are several color
resolutions associated with each image.  The
simultaneous color representations of an image
in Capture are:

Monitor Color Resolution

The Monitors resolution is the setting in
Monitors Control Panel, indicating whether it is
256, Thousands, or Millions of colors or grays.
The Monitors resolution affects the Display
resolution, because a 32-bit color image

displayed on a Monitor set to 8-bit color will
look like an 8-bit color image.

Display Color Resolution

The Display color resolution of an image in
Capture is the quality of the image on the
NuVista+ screen.  One can tell visually if an
image is displayed in 8-bit or 16-bit or 32-bit
color resolution.  However, this representation is
a bit complicated by Capture’s Conversion
menu items in the Special menu.  Converting an
8-bit image to 32-bit color will not visually
change the display quality of the image on the
screen, because there is no way to fill in the
additional color information.  After the

4.1  NuVista+ Capture
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conversion, the Special menu will indicate that
the image is in 32-bit color resolution, even
though it does not appear to be so.  However,
converting an image to a lower color resolution
will indeed cause a change in display quality.

Saved Color Resolution

The Saved color resolution of an image in
Capture is the most important factor in image
quality.  Even if an image is converted to a
lower color resolution (e.g., from 32-bit to 16-
or 8-bit), if the image is saved as a 32-bit image
before being converted, it can always be
reloaded into Capture, bringing back all of its
32-bit color splendor.

4.1  NuVista+ Capture
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Converting an Image

Converting to a Higher Resolution

Images currently in 8- or 16-bit resolutions may
be converted to 32-bit by selecting Convert To
32-Bit Image from the Special menu.  A dialog
box will ask you if you want to save the image
in the current resolution before converting.  If
you click NO, the conversion will take place but
will not affect the actual file until the image is
saved.  If you click YES, the image will be
saved at the current resolution and then
displayed at the new resolution.  If you click
CANCEL, the image will be neither saved nor
converted.

4.1  NuVista+ Capture
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When converting an image to a higher
resolution, the display quality may not improve,
as there is no way to fill in the additional color
information.  However, conversion is necessary
in order to achieve 32-bit Overlay.

Converting to a Lower Resolution

An image in 32-bit resolution may be converted
to 16-bit resolution by selecting Convert To 16-
Bit Image from the Special menu.  Use this
menu item to obtain smaller files or to sharpen
contrasts in the image.  A dialog box will ask
you if you want to save the image in the current
resolution before converting the display
resolution.

If you click NO, some color information
will be lost if the file is not saved at the

higher resolution before it is converted.  If you
click YES, the image will be saved at the
current resolution and then the image will be
displayed at the new resolution.  If you click
CANCEL, the image will be neither saved nor
converted.

4.1  NuVista+ Capture
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A 32-bit or 16-bit image may be converted to 8-
bit resolution by selecting Convert To 8-Bit
Image from the Special menu.  Use this menu
item when storage limitations exist or when
dealing with an older application that accepts
only 8-bit images.   A dialog box will ask you if
you want to save the image in the current
resolution before converting the display
resolution.

As before, if you click NO, some color
information will be lost if the file is not

saved at the higher resolution before it is
converted.  If you click YES, the image will be
saved at the current resolution and then the
image will be displayed at the new resolution.

If you click CANCEL, the image will be neither
saved nor converted.

4.1  NuVista+ Capture
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Determining the Display Resolution of an
Image

The color resolution at which an image is
currently displayed can be determined by noting
which one of the three conversion menu items is
dimmed in the Special menu.  In the case when
there are two items dimmed, the image is
currently displayed at 8-bit color resolution.

In some cases, especially after one or
more conversions, the actual

appearance of the image may not seem to match
the color resolution indicated by the dimmed
menu item.

Using the Clipboard

Copying a Portion of an Image to
Clipboard

To copy a portion of an image to the Clipboard,
move the cursor over the Capture Window.
(The Fit Window to Screen option must be off
to make a selection.)  Make the selection by
dragging the mouse.  A dotted box will appear
outlining the selected portion.  Select Copy from
the Edit menu.  The selected portion of the
image is now in the Clipboard.

The dimensions (in pixels) of the
selection will appear in the horizontal

scrollbar if you hold down the Option key while
selecting.

4.1  NuVista+ Capture



Page 4-12

CHAPTER 4

Showing Clipboard

Selecting Show Clipboard from the Edit menu
will cause the Clipboard Window to appear,
with the selected portion of the image in it.

Saving

Saving an Entire Captured Image

To save an image, simply select Save... from the
File menu.  In the Save dialog box, use the Eject
and Drive buttons to locate the desired
destination disk.  Type the name of a file in the
edit box, and click SAVE.  The image can now
be reopened in Capture, or imported to other
Macintosh applications, such as PageMaker and
PhotoShop.

4.1  NuVista+ Capture
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If the image is an 8-bit or 16-bit image, it will
be saved as a PICT file.  If the image is a 32-bit
image, the image will be saved as a PICT file by
default, but you have the option of saving it as a
32-bit TGA file.

Saving a Portion of a Captured Image

Select a portion of the image to be saved by
dragging the mouse over the Capture Window.
(The Fit Window to Screen option must be off
to select.)  While the dotted lines are still
visible, select Save... from the File menu.  In the
Save dialog box, use the Eject and Drive buttons
to locate the desired destination disk.  Type the
name of a file in the edit box, and click SAVE.

The portion of the image can now be reopened
in Capture, or imported to other Macintosh
applications, such as PageMaker and
PhotoShop.

If the image is an 8-bit or 16-bit image, it will
be saved as a PICT file.  If the image is a 32-bit
image, the image will be saved as a PICT file by
default, but you have the option of saving it as a
32-bit TGA file.

4.1  NuVista+ Capture
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Formats

The two file formats available for saving
captured images are PICT and 32-bit TGA.  If
the image is an 8-bit or 16-bit image, it will be
saved as a PICT file.  If the image is a 32-bit
image, the image will be saved as a PICT file by
default, but you have the option of saving it as a
32-bit TGA file.

The icons for PICT and TGA files created by
Capture are the same in all respects except one.
The word “PICT” or “TGA” appears at the
bottom of the icon, just above the name of the
file.

4.1  NuVista+ Capture
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Opening a PICT or TGA File

To open any PICT or 32-bit TGA file in
Capture, select Open... from the File menu.  In
the Open dialog box, use the Eject and Drive
buttons to locate the desired file, either a PICT
or TGA file.  Double click on the filename or
click on it once and click the OPEN button.  The
image will appear in the Capture Window.

The image currently in the Capture Window
will be replaced by the image being opened.  If
the current image has not been saved, you will
be asked if you want to save the image before
opening the new image.  Click YES to save and
open the image, NO to open without saving the
current image, or CANCEL to neither save nor
open.

4.1  NuVista+ Capture
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Printing

Page Setup

Selecting Page Setup... from the File menu will
give you access to the print options dialog
associated with the printer specified in the
Chooser.  See your Macintosh owner’s manual
for more information.

Print

Selecting Print... from the File menu will cause
the image to be printed on the printer currently
specified in the Chooser.

4.1  NuVista+ Capture



Page 4-17

CHAPTER 4

Quitting Capture

To quit Capture, select Quit from the File menu.
If the current image has not been saved, you will
be asked if you want to save it.  Click YES to
save and quit, NO to quit without saving, or
CANCEL to remain in Capture.

4.1  NuVista+ Capture
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Overlaying Live Video

Suppose you would like to lay a PICT file of a
ship over a live video sequence of moving
waves, and save the whole combination out to
video tape.  The NuVista+ was designed with
tasks like this in mind.  To do this, you would
either import a PICT (or TGA) file of the ship,
or capture a frame of video having a ship in it.
Then all the pixels not part of the ship would be
tagged, based on their color, as pixels that will
soon show video.  The colors used to indicate
which pixels will show video are called Key
Colors.  One or more Key Colors may be
chosen in Capture.

Selecting a Key Color

To select a Key Color in Capture, make sure the
image in the Capture Window is in 32-bit color.
To verify the resolution of an image, note which
of the three conversion menu items is dimmed
in the Special menu.  If Convert To 32-bit
Image is dimmed, the image is currently in 32-
bit color.

4.1  NuVista+ Capture
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Select Choose Key Color... from the Alpha
menu.  (If the menu item is dimmed, make sure
that neither Fit Image to Window nor Fit
Window to Screen is checked in the Special
menu.)  A window titled Key Color will appear,
with a black color circle on the left that will
later indicate the color(s) that you have chosen.
On the right is a column showing the levels of
red, green, blue, hue, saturation, and brightness
for the pixel currently under the cursor.  Below
the cursor is a brightness indicator bar.

4.1  NuVista+ Capture
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Move the cursor about the image in the Capture
Window.  The color in the color circlewill
match the color (or range of colors) of the
pixel(s) to which the cursor is currently
pointing.  When you have found either a pixel
(or range of pixels via dragging) of the color(s)
where you intend to see video,  click the mouse
once.  The chosen color(s) is now a key color.

In Capture, more than one key color may be
chosen.  Having several key colors allow you to
specify a number of colors without broadening
the tolerance for each color.  Simply continue
clicking colors on the NuVista+ screen as
described above, or drag over another range of
colors and then click the mouse.

When you are done, close the Key Color
window.

To cancel the last key color chosen,
select Undo from the Edit menu.

4.1  NuVista+ Capture
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4.1  NuVista+ Capture

Capture Preferences

To set one or more of the Capture preferences,
select Preferences... from the Special menu.
Each option is described below.

Screen Capture Resolution

The screen resolution refers to the dimensions
(W x H) of the Capture Window in pixels.

Color Resolution

The three radio buttons on the right side of the
Preferences dialog indicate which color
resolution is currently set.

An image may be captured at: "256" (8-bit
Color Look-Up Table), "thousands" (16-bit
Direct), and "millions" (32-bit Direct).  By
default, an  image is captured in "thousands."
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Clicking the radio button next to "256"
will cause the image to be captured in

16-bit color and then mapped to 8-bit color
using the best 256 colors available.

Use Live Time-Out During Capture

When Capture Image is selected from the File
menu, having this option checked causes the
NuVista+ to automatically capture after a two-
second delay.  There is no need to click the
mouse while the live video is displaying to
initiate the capture.  Place an X in the box next
to this option if you need to be away from the
mouse while capturing or if your monitor is not
compatible with Interlaced mode.

4.1  NuVista+ Capture

When disabling this option (unchecking the box
next to it), you will be warned that you need a
multi-scan rate monitor (i.e., one that is
compatible with Interlaced mode.)  If you have
the Expert (No Alerts) option checked, you will
not receive this warning.

Expert (No Alerts)

Placing an X in the box next to Expert (No
Alerts) option will cause all the warning and
prompting dialog boxes that usually come up to
be suppressed.  For example, when this option is
checked, you will not be prompted to save the
image in the Capture Window before closing it
or opening a new image.
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Open Startup Window on NuVista+
Screen

Placing an X in the box next to the "Open
Startup Window On NuVista+ Screen" option
will cause the Capture Window to appear on the
NuVista+ screen when Capture is first launched.
This option is available as a convenience.

Pseudo Live Video In Window

Placing an X in the box next to the Pseudo Live
option will cause a slowed version of the live
video to appear on the screen when the Capture
Window is not on a multi-scan rate monitor.
The speed is approximately one frame per

second.  This option is used primarily to see the
video input the NuVista+ is receiving when a
multi-scan rate monitor is not available.

Capture Immediately

Placing an X in the box next to Capture
Immediately option will initiate a capture
immediately after the Capture Image menu item
is selected from the File menu.  Recall that
when this option is not checked, the NuVista+
waits for you to click the mouse when you are
ready to initiate the capture.

4.1  NuVista+ Capture
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Key Color Tolerance

Key Color Tolerance is a method of defining a
color range for hue, saturation, and brightness of
the color key selected.  Type a number between
0 and 32767 in each edit box for hue, saturation,
and brightness.  Click OK.

The number in each Key Color Tolerance box
represents how much leeway will be given when
a key color is chosen in the Key Color window.
For example, if the tolerance is set to 0 for all
three boxes, only those pixels exactly matching
the Key Color pixels will have live video when
the NuVista+ is set to Interlaced mode and
Overlay is toggled ON.  This case imitates how
the Select Color button in the Blender operates.
On the other hand, when the tolerances for all
three boxes is set to 32767 (the highest possible

4.1  NuVista+ Capture
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setting), all colors in the image will qualify as
key colors when one pixel’s color (or a range of
pixel colors) is chosen as the key color.

The default Key Color Tolerance setting is 5000
for hue, saturation, and brightness.  This number
specifies a relatively small range of pixel colors
qualifying as a key color.

Alpha Filter Sharpness

Determines how much filtering will be done
when the Filter Alpha Channel (Alpha Menu) is
envoked.  This is useful if you want to smooth
out the jagged look that occurs between live
video and graphics when using video overlay.
The range for Alpha Filter Sharpness is 25 to
255.  The lower the value, the smoother the
graphic image appears (i.e., more filtering
occurs.)

4.1  NuVista+ Capture
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The Alpha Channel

The Alpha channel can be used to specify any
non-color aspects of a pixel. For example, some
Macintosh applications may make use of an
image’s Alpha channel to specify which pixels
are used as a mask or a filter.

In a 32-bit color image, the color of each pixel
is specified by some mixture of red, green, and
blue.  In each pixel, eight bits are used to
specify the amount of red, eight for the amount
of green, and eight for blue, using a total of 24
bits.  The remaining eight bits are called the
Alpha channel.

4.1  NuVista+ Capture

In Capture, the Alpha channel serves two
purposes.  First, the Alpha channel specifies
whether or not a pixel displays video or whether
it displays the image.  Displaying video in
certain pixels of an image is called Overlay.

Second, once the Alpha channel is set, the
image may be saved with the Alpha channel
information and exported to other Macintosh
applications, including those that use the Alpha
channel.
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4.1  NuVista+ Capture

Alpha Channel.  Show Alpha Channel is a way
to distinguish which colors in an image have
been tagged.

Filter Alpha Channel

This feature works in conjunction with the value
placed in the Alpha Filter Sharpness box found
in "Preferences" (Special Menu).  Selecting
Filter Alpha Channel will smooth out the jagged
look that occurs between live video and
graphics when using video overlay.

Saving the Alpha Channel

If there is a checkmark next to the Save Alpha
Channel menu item in the Alpha menu, then the
Alpha channel information will be saved with
the image.  A checkmark is automatically placed
next to the menu item when a Key Color is
chosen.  If you do not want the Alpha channel
information to be saved with the image when
Save... is selected from the File menu, select this
menu item again so that there is no checkmark
next to it.

Show Alpha Channel

Selecting (i.e., placing a checkmark next to) the
Show Alpha Channel displays the contents of
the Alpha Channel.  That is, when an image has
color(s) "tagged" with the Choose Key Color
feature (so that video can be seen through those
colors), those tagged colors are stored in the
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Clearing the Alpha Channel

When you have selected one or more Key
Colors, the Alpha channels of the selected pixels
carry information about Overlay.  Selecting
Clear Alpha Channel from the Alpha menu will
erase all overlay information for the entire
image.

Interlace

To be able to view video on the NuVista+
screen, it must be in Interlaced mode.  To set the
NuVista+ screen into Interlaced mode before
Overlaying, select Interlace from the Alpha
menu.  Alternatively, use the Interlace
MasterKey.

4.1  NuVista+ Capture
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32-Bit Alpha Blend

To cause video to show through the pixels
matching the chosen Key Color(s), first make
sure the image has been converted to 32-bit
color resolution.  To verify this, note which of
the three conversion menu items is dimmed in
the Special menu.  If Convert To 32-Bit Image
is dimmed, the image is in 32-bit color.  (The
display quality may not actually improve after
the conversion.  See also “Converting an
Image,” earlier in this Chapter.)  In addition,
verify that your monitor is set to display in
Millions of colors, using the Monitors Control
Panel.  Now place the NuVista+ screen in
Interlaced mode and select 32-Bit Alpha Blend
from the Alpha menu.

4.1  NuVista+ Capture

Unlike the Interlace or Alphablend
MasterKey, the Overlay MasterKey

should not be used in Capture.

When the NuVista+ screen is Interlaced and
Alpha Blend is toggled ON, selecting this menu
item will toggle Alpha Blend OFF, while
leaving the NuVista+ screen in Interlaced mode.
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Choosing among two or more
NuVista+ cards

When two or more NuVista+ cards are installed
in the Macintosh, a new menu titled “NuVista+”
will appear.  Each menu item in this menu refers
to one NuVista+ card, identifying the amount of
memory on the card and the slot it is in.  (Slots
are labelled with hexadecimal numbers.  The
left-most slot has the lowest number.)

By default, Capture will use the left-most
NuVista+ in the Macintosh.  The Capture
Window should be on the screen associated with
this card, and the video input to be used for the
Capture should be connected to this card.  When

4.1  NuVista+ Capture

an image is captured, the video will fill the
screen associated with this card.

If you select a NuVista+ card other than the
default, be sure you drag the Capture Window
to the screen associated with this card.
Although an image can be captured when the
Capture Window is on another screen, you will
not be able to see video overlay.
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4.2  HyperCard XCMDs

For those wanting to incorporate features of the
NuVista+ into HyperCard 2.0 HyperTalk
scripts, Truevision provides several HyperCard
External Commands (XCMDs).  For more
information, consult the Apple HyperCard
Script Language Guide, published by Addison
Wesley, and the XCMD stacks on your
“NuVista+ Software” diskette.

4.3  Director XOBJs

For those wanting to incorporate features of the
NuVista+ into MacroMedia Director Lingo
scripts, Truevision provides a Director External
Object (XOBJ).  For more information, consult
the XOBJ Read Me file on your NuVista+
“NuVista+ Software” diskette and your “Video
Production Examples” diskette.

4.2  XCMDs;  4.3  XOBJs
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4.4  VDIG; 4.5  Gamma DA

4.4  NuVista Video Digitizer (VDIG)
For QuickTime™

The NuVista VDIG provides the necessary
connection between the Truevision NuVista+
and a QuickTime-compatible movie recording
application.  This enables any movie recording
application to access the frame capture
capabilities of the NuVista+ card.

4.5  Gamma Correction Desk Accessory

Gamma DA is a useful tool for adjusting the
gamma values associated with a particular
monitor/video card combination.  Gamma
values change the color temperature of the
monitor.  Apple makes certain assumptions
about how color should be corrected.  The
Gamma DA allows you to change those
assumptions and assign your own gamma
values.
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APPENDIX A - QUESTIONS AND ANSWERS

Monitor Questions

Q) Can a NuVista+ card be used with an
Apple RGB Color Monitor?

A)  Yes, but it won’t give you access to the full
power and flexibility of the NuVista+.
NuVista+ is a “multi-scan rate” graphics
card, meaning that it can drive display
screens operating at different video scan
frequencies, all under software control.  The
Apple RGB Color Monitor, on the other
hand, is a “fixed-scan rate” monitor,
meaning that it can operate only at one scan

Monitor Questions

rate.  With the appropriate cable (CA-5), and
as long as the default driver in the NuVista+
is not replaced with another driver, the
NuVista+ will work with the Apple Color
Monitor with no hardware or software
changes.  However, you will not be able to
see live video on the Apple monitor, thus
making capture and overlay difficult.

Q) Which monitors will work with the
NuVista+ card?

A) Since NuVista+ is a multi-scan rate graphics
card, it is best suited for use with a multi-
scan rate monitor.  The multi-scan rate
monitor should have analog RGB inputs and
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be able to scan horizontally from 15 KHz to
35 KHz. Note that you should also consider
the monitor requirements specified by the
application software which you are
considering for use with your NuVista+.

Video Questions

Q) Can the NuVista+ card be used to
videotape the Macintosh II screen?

A) If the Macintosh II monitor is an Apple
RGB Color monitor, the answer is no.  The
Apple RGB monitor is non-interlaced,
whereas all videotape recorders are NTSC or
PAL interlaced devices.  To videotape a

Video Questions

computer screen, the monitor must be
switched into interlaced mode.  The Apple
RGB monitor is not capable of doing this.
To videotape a multi-scan rate computer
monitor, use the Interlace MasterKey to put
the computer screen into Interlaced mode.
Run a branching cable from the camera’s
Video Out to the NuVista+ Video In, and
from the camera’s Video Out to the VCR’s
S-video or Composite Video In.  An
interlaced monitor connected to the
recording VCR will show the results, with
no scan lines present.
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Q) Will the Macintosh II screen “flicker” if
the NuVista+ card is operating in NTSC
or PAL mode?

A) Yes.  The Macintosh II user interface
display was designed for non-interlaced
displays, not with NTSC or PAL
videotaping in mind.  Certain aspects of the
interface, like the thin horizontal lines in the
title bar of every window, will seem to
flicker any time the screen is put into an
NTSC or PAL interlaced mode.  This is
because the single pixel width horizontal
lines are being shown only half as often as
they normally would in the non-interlaced
mode of operation.

Q) Can a consumer grade video camera be used
to capture pictures with the NuVista+ card?

A) Yes.  Most consumer grade video cameras
use a standard type of video signal called
“composite video” which, in effect,
combines the four signals used by the
NuVista+ card—red, green, blue, and sync
into one signal.  Use the VIDI/O Control
Panel to indicate that you are receiving input
as a Composite Video signal.

Q) Can animations be made with a NuVista+
card?

A) Naturally, you need to have animation
application software which can take

Video Questions
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advantage of the hardware features of
NuVista+. The NuVista+ card provides the
ideal hardware environment for making real-
time animations and frame-by-frame or cel
animations.  For more information, contact
MacroMedia, 600 Townsend St., San
Francisco CA 94107 (415) 442-0200
concerning real-time animations; and
DiaQuest, Inc.  1440 San Pablo Ave.,
Berkeley CA 94702  (415) 526-7167
concerning frame-by-frame animations.

Q) How can I calibrate the video levels of my
NuVista+ card?

A) Truevision sells a NuVista+ Calibration Kit
designed for qualified technicians to
perform oscillator and video input/output

adjustments. The kit includes user
documentation, an application “NuVista+
TuneUp™” and a set of connector wings.
Contact your Authorized Truevision
Reseller to obtain the kit.

Software Questions

Q) What software is provided with a
NuVista+ card?

A) A NuVista+ card is shipped with the
following software:   NuVista+ CloseUp,
MasterKeys, Blender, VIDI/O Control
Panel, Chroma Keyer, Capture, SetUp,
NuVista+ Drivers,  NuVista+ Photo Stack,
Video Digitizer, Gamma Correction DA,
Director XOBJs, and HyperCard XCMDs.

Software Questions
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Q) What software is available for the
NuVista+ card?

A) All software written for the Macintosh that
adheres to Apple’s standard QuickDraw
graphics routines can be run on the
NuVista+ card.  This list includes paint
programs, drawing programs, word
processors, spreadsheets, etc.  Magazines
such as MacWeek, MacWorld, or MacUser
are also excellent sources for software
guidance.

Q) How can a user keep current with the
latest on software for the NuVista+ card?

A) A good source of information on the latest in
NuVista+  software is the Software Catalog,
published by Truevision.  This publication,
along with the regular graphics and
Macintosh magazines and trade shows, are
invaluable sources for identifying software
for the NuVista+ card.  In addition,
AppleLink and CompuServe can be used to
find the latest software for the NuVista+.
Truevision’s address on AppleLink is
TRUE1.  Use the following path:

software sampler: 3rd party demos/updates: software
updates: truevision software updates:

For CompuServe, look in the Multi-media
Vendors Forum (Go MULTIVEN).

Software Questions
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Q)  Why is 24-bit color called “true color?”

A)  By mixing red, green, and blue hues, the eye
can determine about 7 million different
colors.  However, we see certain colors,
mostly oranges and reds, better than others.
Because of this the computer must
compensate in these areas to accomplish
what the human eye recognizes as “true
color” and thus most experts agree that 16.7
million colors are necessary to obtain photo-
quality images.  Twenty-four bits per pixel
are needed to achieve 16.7 million colors on
the computer.

Q) If 24-bit color is true color, why 32-bit
QuickDraw?

A)  Although 32-bit QuickDraw assigns 32 bits
to every pixel on the display, only 24 bits
are needed to represent colors.  The
remaining 8 bits are reserved for use in
video overlay and special video effects
applications.  This extra information is
referred to as the “Alpha channel.”

Software Questions
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Q) What is a “NuVista+ driver”?

A) A NuVista+ driver is a set of instructions
that defines the spatial resolution at which
the NuVista+ card will operate.  The user
may wish to change the screen resolution
from the default 640 x 480,  35KHz
horizontal scan rate and 67Hz vertical scan
rate to the standard TV studio size, for
example.  Using the NuVista+ SetUp
program, the user may customize the
NuVista+ to his/her application and monitor
configuration.

Q) What software tools are available for
programming the NuVista+ card?

A) HyperCard XCMDs are provided with the
NuVista+ card to allow you to use all the
features of the NuVista+ from within
HyperTalk scripts.

A NuVista+ XOBJ is provided to allow you
to use all the features of the NuVista+ from
within MacroMedia Director 2.0 or above
Interactive scripts.

Q) How can I develop software for the
NuVista+ products?

A)  If you are interested in developing software
for the NuVista+, please contact our
Developer Services department at 317-841-
0332 or AppleLink “TRUE.DEVSUPP” for
more information.

Software Questions
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Support Questions

Q) How can I get a technical reference
manual for NuVista+?

A)  A technical reference manual is available for
a nominal fee from your Authorized
Truevision Reseller.

Support Questions

Q) When I have technical questions
regarding the NuVista+, whom should I
contact?

A) First consult your NuVista+ User’s Guide.
Then, contact your Authorized Truevision
Reseller.  Last, call Truevision Technical
Support.  Refer to “Using Technical
Support” on the next page.
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Using Technical Support

Using Technical Support

The number is (317) 577-8788.  Before calling
Technical Support, perform these tasks:

— If there is an error code, be sure to write down the
message.

— Be able to provide your system configuration.  This
should include:
• Truevision Product Type (NuVista+ 1, 2, or 4 Mb)
• Type of Machine
• Other Expansion Cards in Machine (e.g., network

card, fax card, etc.)
• Software Applications (and version numbers) that

are being used
• Version and Date of NuVista+ Setup Software

Please be at your computer and ready to
replicate the problem or perform the suggestions
of the technican.

Support is also provided from the following:

CompuServe (Go Truevision):  Library No. 6
Technical Support Fax:  (317) 576-7770
Marketing Developers:  (317) 576-7776
Sales Administration:  (317) 841-0332
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APPENDIX B - SETUP

The NuVista+ SetUp Utility provides the
opportunity to accomodate other monitor screen
resolutions and scanning modes.  It is intended
for the advanced user going beyond the default
driver implementation.

A driver is a set of instructions loaded into
NuVista+ non-volatile RAM that operates the
NuVista+ card.  The default driver specifies a
screen resolution of 640 x 480 pixels, a
horizontal scan rate of 35KHz, a vertical scan
rate of 67 Hz, non-interlaced mode.  This is the
only setting available for the fixed-scan rate
Apple RGB Color monitor.

If you have a multi-scan rate monitor, you may
choose to load in another driver.  The one you
choose must be compatible with the scanning
mode of your monitor (NTSC or PAL), the
horizontal and vertical scanning rates, and the
general size in pixels of the screen.  Consult the
owner’s manual of your monitor for this
information.  If you choose a driver that is
incompatible with your monitor, you may get a
funny looking screen or worse yet, a totally
incoherent screen.

Users who are concerned with professional
video tape productions may want to load in a
different driver.  The most common drivers are:

SETUP
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Screen Size H scan rate V scan rate

a.  756 x 486 (NTSC) 15.734 KHz 59.940 Hz

b.  512 x 486 (NTSC) 15.734 KHz 59.940 Hz

c.  720 x 486 (NTSC) 15.734 KHz 59.940 Hz

d.  512 x 400 (NTSC) 15.734 KHz 59.940 Hz

e.  768 x 576 (PAL) 15.625 KHz 50.000 Hz

Which of the four NTSC drivers is chosen
depends on the type of application you are
engaging in, the resolution of any previously
captured images that will be displayed, and of
course, the requirements of the display monitor.

The first screen resolution might be used in
broadcasting situations, while the second might
be used in underscanned mode.  The third
resolution is used when connecting to the D1
digital video standard.

Users with a 1Mb NuVista+ card may wish to
load in the 512 x 486 driver in order to achieve
32-bit overlay capabilities.  Other drivers will
only yield a 16-bit display.

SETUP
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Loading a Driver

1.  Launch the NuVista+ SetUp Utility by
clicking on its icon.

2.  Select Open... in the File menu.  In the Open
Dialog Box, use the Eject and Drive buttons to
locate the file “NuVista+ Drivers.”  Double-
click on the name or click on it once and click
OPEN.  The following dialog box appears.

Loading a Driver
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The dialog box shows the default driver 640 x
480, with the non-interlaced mode (scan rate)
implemented at startup.  This driver is
compatible with Apple RGB Color Monitors,
but provides the lowest quality video signal.
Note the information about vertical and
horizontal scan rates for non-interlaced, NTSC,
and PAL modes in the box at the lower right.
Because there are three modes in this box, three
choices are available under “Select Startup Scan
Rate.”

3.  The slot in which your NuVista+ card(s) was
placed will be indicated in the diagram in the
upper right corner.  If you have more that one
NuVista+ card installed, choose the one which
will have the driver loaded into it by clicking on
the slot in the diagram.

Loading a Driver
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4.  Select a resolution appropriate for your
application and monitor.  You may need to
scroll the window to see all the choices.

5.  Select a mode (scan rate) in which the
monitor will operate at startup.  Your choices
will usually include Non-Interlaced (“MAIN”),
NTSC, or PAL.  Hold the mouse button down
on the pulldown menu below the words “Select
Startup Scan Rate.”  Your other choices now
appear as in a menu.

6.  Click LOAD to begin loading the driver.

7.  When the driver is finished loading, click
QUIT.

8.  Restart the Macintosh to activate the
NuVista+ driver.  If you have an incoherent
display it is likely you have loaded an
incompatible driver.  If this is the case, contact
your Truevision Reseller or call Truevision
Technical Support at (317) 577-8788.

Loading a Driver
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Save/Restore DAC Values

Save/Restore DAC Values

The calibration values of the NuVista+ are
stored in non-volatile memory on the board.
Saving these values through this dialog will
allow them to be restored if they should become
corrupted.  Select the NuVista+ by clicking on
its representation in the dialog, and click on
Save Settings or Restore Settings as appropriate.
Close will close the dialog, and Quit will quit
the SetUp application.
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APPENDIX C- VIDEO CONFIGURATIONS

The following pages illustrate some typical
video configurations using the NuVista+. Each
icon represents a piece of equipment, such as a
camera, VCR, or monitor.

The lines with arrow-heads represent cables
going from one piece of equipment to another,
and the direction of the arrow signifies the
direction of data flow.

The letters indicate the type of video connector
at each location, using the cable codes listed
below each diagram.

Keep in mind that these configurations are just
examples;  you are encouraged to configure
your own system to suit your needs.

Video Configurations
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Configuration #1

Configuration #1

A=4 BNC for RGB
B=1 BNC for Composite Video
C=4-pin DIN for S-Video
D=9-pin D-type
A*=4 BNC for RGB + 1 BNC for Composite Video or S-Video subcarrier source, since NuVista+ Video Out is Composite or
S-Video

Camera
NuVista+

VCR
Monitor

Monitor

A
B or
C

D

D

B or 
C

A 
or 
D

B or 
C

B or
C*
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Configuration #2

NuVista+
VCR

Monitor

D

D

B or 
C

B or 
C

B or 
C

VCR

B or
C

A=4 BNC for RGB
B=1 BNC for Composite Video
C=4-pin DIN for S-Video
D=9-pin D-type

Configuration #2
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Configuration #3

A=4 BNC for RGB
B=1 BNC for Composite Video
C=4-pin DIN for S-Video
D=9-pin D-type

NuVista+

Monitor

D

D

B

A 
or 
D

Video PrinterVCR
B or 
C

Configuration #3
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Configuration #4

A=4 BNC for RGB
B=1 BNC for Composite Video
C=4-pin DIN for S-Video
D=9-pin D-type
E=15-pin D-type for Apple monitor
?=Unspecified

Camera
NuVista+

MonitorA
B or
C

D

D

A 
or 
D

Other Video 
Card

Monitor
E?

Configuration #4
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Configuration #5

NuVista+
VCR

Monitor
D

D

B or 
C

B or 
C

CVCR

Camera A

Laser Disk B

Note: Although three input devices of different types are 
attached to the NuVista+ with a branching cable, only one is 
used at a time for video input.

B or 
C

*

A=4 BNC for RGB
B=1 BNC for Composite Video
C=4-pin DIN for S-Video
D=9-pin D-type
A*=4 BNC for RGB + 1 BNC for Composite Video or S-Video subcarrier source, since NuVista+ Video Out is Composite or
S-Video

Configuration #5
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Configuration #6

A=4 BNC for RGB
B=1 BNC for Composite Video
C=4-pin DIN for S-Video
D=9-pin D-type
?=Unspecified

Camera
NuVista+

Monitor

Monitor

A
B or
C

D

D

A

A

loop-through

?

Configuration #6
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Configuration #7

A=4 BNC for RGB
B=1 BNC for Composite Video
C=4-pin DIN for S-Video
D=9-pin D-type

Camera
NuVista+

Monitor

A
B or
C

D

D

A

A
Monitor

Monitor

Distribution 
Amplifier (DA) A

A

A

Configuration #7
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NuVista+ SPECS

APPENDIX D - NuVista+ SPECS

Host Type: Apple Macintosh II series computers
Card Size: 12.875" x 4.0" x .75"  Occupies a single slot
Data Bus Width: 32-bit, 16-bit, or 8-bit transfers supported
Bus Clock: 10 MHz
Data Transfer Rate: 3.6 MB/sec
Power Consumption: 14 Watts
Processor Type: Texas Instruments TMS34010 50 MHz

Graphics System Processor (GSP)
Video Memory: 1MB/2MB/4MB
Output Color Lookup Tables: Three 256 x 8 tables used for the Red, Green, and Blue outputs
Analog to Digital Converters: Three 8-bit ADCs (red channel, green channel, blue channel)

Software adjustable RGB level and offset
Digital to Analog Converters: Three 8-bit DACs (red channel, green channel, blue channel)

 Adjustable RGB balance
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NuVista+ SPECS

Video Cross Point: 32-bit bi-directional custom video cross point
(for video overlay and programmable pixel size)

Row Tables: 2K x 16-bit lookup table for frame buffer row access
Genlock/Sync Generator: Fully integrated, broadcast quality genlock and sync generator
Swixel Logic Array: 32/16/8-bit pixel alignment
Non-Volatile RAM: 8K x 8-bit electrically alterable declaration ROM
32-bit QuickDraw Compatibility:Supports 32, 16, and 8 bits per pixel
Composite/S-Video Decoder: Software selectable composite, S-video, or RGB input source
(NTSC or PAL version) Software adjustable hue (NTSC only), saturation, contrast, and

brightness
Robust genlock (lock to video disks, still video cameras)

Composite/S-Video Encoder: Simultaneous composite, S-video, and RGB outputs
(NTSC or PAL version) Accurate burst gate blanking (meander burst gate)

Software adjustable subcarrier phase (when locked to input video)
75Ω output impedance on all outputs
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NuVista+ SPECS

Digital Linear Keyer (Mixer): 256 levels of digital linear keying based on alpha channel
Control registers allow fades to any color
Overlay bit can select between any two mix ratios
Programmable video overlay index

Digital Chroma Keyer: High quality chroma key over blue background
Shadow preservation
Requires professional backdrop and lighting
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NuVista+ SPECS

Programmable Screen Attributes
• Horizontal/Vertical Addressable Resolution
• Horizontal/Vertical Capture Resolution
• Horizontal/Vertical Display Resolution
• Horizontal/Vertical Zoom, Magnifications 2x,
4x, 8x, 16x
• Horizontal/Vertical Panning

Programmable Pixel Attributes
• Number of bits/pixel (32/16/8)
• Pixel Clock (display)/ Sample Clock (capture)
• Pixel Specification (color mapped or true
color)
• Video and/or Graphic Overlay
• Capture Mask/Write Mask

Programmable Video Attributes
• Interlaced/Non-Interlaced Display
• Horizontal/Vertical Scan Rate
• Horizontal/Vertical Blanking Interval
• Horizontal/Vertical Sync Width
• Horizontal Front/Back porch
• Vertical Equalization and Serration Pulses
• NTSC/PAL/Non-Standard Modes
• Master/Slave (genlock) Modes
• Live/Capture/Display/Overlay Modes

Analog Video Adjustments
• R/G/B Input Gain
• R/G/B Input Offset
• R/G/B Ouput Level
• NTSC/PAL Center Frequency
• Horizontal Fine Phase
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NuVista+ SPECS

Pixel Specifications
• Mono, 8-bit Pixels:
One 8-bit channel, 256 grey levels
• Mono, 16-bit Pixels: Three 5-bit channels, 32 grey levels
• Mono, 32-bit Pixels: Four 8-bit channels, 256 grey levels
• Index, 8-bit Pixels: 8-Index, 256/16M colors
• Color, 8-bit Pixels: 3-R, 3-G, 2-B:  256 colors
• Color, 16-bit Pixels: 1-A, 5-R, 5-G, 5-B:  32K colors
• Color, 32-bit Pixels: 8-A, 8-R, 8-G, 8-B:  16M colors
• Overlay, 8-bit Pixels: Video
• Overlay, 16-bit Pixels: Video
• Overlay, 32-bit Pixels: Video
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NuVista+ SPECS

Maximum Capture Resolution
• NTSC (RS-170A): 756 x 486 @ 30 Hz
• PAL (CCIR-624): 768 x 575 @ 25 Hz

Maximum Interlaced Display
• NTSC (RS-170A): 1536 x 486 @ 30 Hz
• PAL (CCIR-624): 1536 x 575 @ 25 Hz
• High Resolution: 1024 x 768 @ 30 Hz

Maximum Non-Interlaced Display
• NTSC (RS-170A): 756 x 486 @ 60 Hz
• PAL (CCIR-624): 768 x 576 @ 50 Hz
• High Resolution: 640 x 480 @ 67 Hz

Maximum Sample Clock (capture)
• NTSC (RS-170A): 29.076923 MHz
• PAL (CCIR-624): 29.500000 MHz
• High Resolution: 30.24 MHz

Maximum Pixel Clock (display)
• NTSC (RS-170A): 29.076923 MHz
• PAL (CCIR-624): 29.500000 MHz
• High Resolution: 30.24 MHz
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APPENDIX D

NuVista+ SPECS

Input and Output Connectors
• Composite sync signal with equalization and serration pulses
• 9-pin D-type female input and output connectors
• Branching-type input and output cables available

Pin Number Input Connector Output Connector
1 Ground Ground
2 Ground Ground
3 Red Input Red Output
4 Green Input Green Output
5 Blue Input Blue Output
6 Composite Video Input Composite Video Output
7 Composite Sync Input Composite Sync Output
8 Luma Input (S-video) Luma/H sync Output
9 Chroma Input (S-video) Chroma/V sync Output
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Codes:

A = 4 male BNC (for R, G, B, sync)

B = 1 male BNC

C = 4-pin male DIN (for S-Video)

D = 9-pin male D-type (for Sony 1302 RGB
Multi-Scan Monitor, or GVM1310 or
GVM2020 Multi-Scan Monitors))

E = 15-pin male D-type (for Apple RGB Color
monitor)

If your configuration requires a different cable,
we suggest obtaining a cable from Cables-to-Go
(1-800-826-7904).  Consult Appendix D of
the NuVista+ User's Guide for pin assign-
ments before calling them.  For other Truevision
product accessories, call 1-800-933-8865.

APPENDIX E

APPENDIX E - CABLES

The following cables are available from your
Truevision Reseller.  A cable having more than
one type of connector on an end is a branching-
type cable, and can be used to connect more
than one output device to NuVista+ Video In*
or Out.

Cable # NuVista+ In or Out Other end
CA-2 9-pin D-type male A
CA-3 9-pin D-type male A, B
CA-4 9-pin D-type male D
CA-5 9-pin D-type male E
CA-6 9-pin D-type male A, B, C
CA-7** 9-pin D-type male B, C, D

*See Configuration #5 in Appendix B of this Guide.

**CA-7 can only be used as an output cable.

CABLES
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GLOSSARY

NuVista+

GLOSSARY

bandwidth
The rate at which a monitor’s display is redrawn
or “refreshed,” measured in millions of cycles
per second, or megahertz (MHz).

blanking
The time during which the electron beam of a
monitor is turned off and reset to its starting
position for either the next scanline or the next
field.

brightness
Similar to luminance.

chroma key
Superimposing a live video source onto a
computer generated background for special
effects.   The opposite of video overlay.

chrominance
The color component of the television signal.
Chrominance has two components:  hue and
saturation.

composite
A method of encoding a color image using one
composite signal for all three colors.  The signal
is composed of three components:  sync to
provide picture stability, luminance (Y) to
provide picture brightness, and chrominance (C)
to provide color.  This is the basic manner
employed by conventional color TV sets.

convergence
The measure of the accuracy with which a
monitor’s electron gun(s) strikes the individual
phosphors on the picture tube.
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GLOSSARY

NuVista+

CRT
Cathode Ray Tube.  Refers to a type of monitor
that employs an electron beam emitter and a
phosphor-coated screen which glows for an
instant when struck by the electron beam.

field
One of two portions of the screen in an
interlaced scanning display system.  A field
consists of 262.5 lines (NTSC) or 312.5 lines
(PAL).

flicker
Movement of thin horizontal lines resulting
from the alternation of the two fields in an
interlaced display and short persistence
phosphors.

frame
Two fields of an interlaced display.  A frame
consists of 525 lines (NTSC) or 625 lines
(PAL).

frame buffer
Area of video memory on NuVista+ card that
holds the digitized color image.

gamma correction
A mapping employed to correct color variance
across monitors.

genlock
A technique used to synchronize the scanning
and color circuits of the various pieces of
equipment that form a video system.



Page G-3

GLOSSARY

NuVista+

horizontal retrace
The period of time during which the electron
gun moves back to the left after finishing a scan
line.

hue
Tint, color.  The main attribute of a color that
distinguishes it from other colors.

interlaced scanning
Raster scanning method used in television
broadcast signals that divides the screen into
two fields, the first containing the odd numbered
lines of the frame and the second containing the
even numbered lines of the frame.  This is done
by scanning the screen from left to right, top to
bottom on alternate lines 60 times a second (50

in European systems).  Each time the screen is
scanned, a single field is displayed.  The two
fields are interwoven to create a single image.

luminance
Similar to brightness.  Used to describe
differences in the intensity of light reflected
from or through an image independent of its hue
or saturation.

non-interlaced
Raster scanning method that draws all lines on a
display in sequential order in one pass.

NTSC Composite
A video signal standard adopted by the National
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GLOSSARY

NuVista+

Television Standards Committee.  A color
encoding scheme used in the United States,
Canada, Japan, and South America.
Characterized by 525 interlaced lines per frame
at 30 frames per second.

overlay
Superimposing a computer generated
background onto a live video source for special
effects.   The opposite of chroma key.  An
example would be combining a live video signal
with a still video image stored in a frame buffer.

PAL
Phase Alternation (or Alternating) Line.  A
color encoding scheme used in Europe.
Characterized by 625 interlaced lines per frame
at 25 frames per second.

persistence
The duration of the period of illumination of the
pixel after it is struck by the electron beam.
Long persistence phosphors reduce “flicker” on
interlaced displays, but cause “trails.”

phosphor
A substance that glows when hit with an energy
source.  The coating on the inside surface of a
CRT screen is made up of phosphor dots that
emit light when hit by electrons from an
electron gun.

pixel
Abbreviation for picture element;  the smallest
unit of the raster that can be stored, addressed,
or displayed.
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GLOSSARY

NuVista+

QuickDraw
A set of built-in drawing routines that performs
all graphic operations on the Macintosh
computer.

raster
Pattern of horizontal lines scanned by electron
beams in the CRT as it draws the image on a
display.

raster scan
System that scans or draws an image onto the
screen in a succession of scan lines.

refresh
Rewriting of an image on the screen.  The
refresh rate refers to the number of frames
drawn on the screen per second.

RGB
Abbreviation for red-green-blue;  a method of
encoding a color image using a separate signal
for each color.  RGB produces images with
higher color fidelity when compared to
composite video and S-video.

S-video
A method of encoding a color image using two
signals, one for color (C) and one for luminance
(Y).  Also known as YC.

saturation
When referring to colors, the extent to which a
color is made purely of a selected hue rather
than being diluted with white.  It is the property
that makes pink different from a pure red of the
same hue, for example.
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GLOSSARY

NuVista+

scan line
The path of the electron beam as it sweeps from
left to right.

screen resolution
Specified as three components:  dot pitch (size
in mm of the smallest dot the screen can
display), the number of dots on a line, and the
number of lines in a frame.

sync generator
A device that generates the horizontal and
vertical sync signals.

sync
Synchronization.  Refers to signals used to
synchronize the horizontal and vertical scans of
a video signal.

tint
Hue, color.  The main attribute of a color that
distinguishes it from other colors.

vertical retrace
The period of time during which the electron
gun moves back to the upper left corner after
finishing a field.
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NuVista+

INDEX

INDEX
32-bit QuickDraw  1-18, A-5, A-6, A-8

A
Adobe PhotoShop  2-2, 2-8, 2-9, 2-14, 2-16, 2-18, 2-22, 4-12, 4-13

Mode menu
Channel  2-19, 2-21, 2-22
Video Alpha  2-19

Aldus PageMaker  4-12, 4-13
Alpha channel  2-14, 2-15, 2-22, 3-11, 3-12, 4-1, 4-26, 4-27, 4-28, A-6, A-8

Filter  4-27
Filter Sharpness  4-25

AppleLink  A-5, A-8

B, C
branching cable  2-2, 3-34, A-2, C-6
camera  1-1, 2-2, 2-4, 2-5, 2-6, 2-43, 2-45, 3-17, 3-33, 4-1, A-2, C-1
Capture memory requirements  4-1
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NuVista+

INDEX

Capture Window  2-5, 2-7, 2-9, 2-11, 2-13, 4-2, 4-3, 4-4, 4-5, 4-15, 4-20, 4-23, 4-30
Chooser  4-16
Chroma Keying  1-3, 2-1, 2-42, 2-45, 3-38
Clipboard

copying to  4-11
showing  4-12

Composite Video  1-1, 1-2, 2-4, 2-45, 3-17, 3-18, 3-33, 3-34, 3-43, 4-1
connector types  1-12
crawling  2-43
Customer Support  A-9, B-5

D
DiaQuest,  Inc.  A-4
distribution amplifier  C-8
driver  1-4, A-5, B-3, B-4

F
Finder  1-1, 2-37, 3-1, 3-3
flicker  A-3
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NuVista+

INDEX

G, H
genlocking  1-2
HV Sync switch  1-8
HyperCard XCMDs  1-3, 4-31, A-7
HyperTalk  4-31

I
Interlaced mode  1-2, 2-6, 2-12, 3-7, 3-20, 4-29
Input cable  1-15

K
Key Color  2-12, 2-16, 2-26, 2-27, 2-42, 3-10, 3-11, 3-17, 3-35, 3-41, 4-18, 4-24

Blend Interval  2-28, 3-8, 3-10, 3-25, 3-26, 3-28, 3-30, 3-31
Blend Slider  2-27, 2-36, 2-41, 3-8, 3-12, 3-17, 3-21, 3-22
pixels  2-14, 2-20, 2-30, 2-36, 2-40, 2-41, 3-19, 3-21, 3-22, 3-26, 3-27, 3-30, 4-24, 4-25
selecting  2-11, 2-13, 3-8, 3-20, 4-20, 4-27
Tolerance  4-24, 4-25

Key Color window  2-12, 2-13, 4-19, 4-20
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NuVista+

INDEX

L
laser disc player  1-1, 2-2, 2-4, 2-5, 2-6, 2-23, 4-1
Lingo  4-31
loop-through  C-7

M
MacroMind Director  1-1, 2-2, 2-22, 2-23, 2-33

Control menu
Preferences...  2-24

Panel  2-31, 2-32, 2-39
Stage  2-26, 2-27, 2-33
XOBJs  1-3, 4-31, A-7

MacroMind,  Inc.  A-4
memory requirements  4-1
menubar,  removing  4-5
modifier keys  3-5
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NuVista+

INDEX

monitor
Apple RGB Color  2-1, A-1, A-2, B-1, B-4
fixed-scan rate  A-1
multi-scan rate  1-19, 2-1, 2-6, 2-7, 4-22, A-1, A-2, B-1

Monitors Control Panel  1-18, 1-19, 2-3, 2-25, 4-3, 4-29

N
Not Key Color  2-26

Blend Interval  2-28, 3-10, 3-25, 3-30, 3-31
Blend Slider  2-30, 2-36, 2-41, 3-23, 3-24
pixels  2-30, 2-36, 2-40, 2-41, 3-18, 3-19, 3-23, 3-30

NuVista+ Blender  1-18, 2-3, 2-26, 2-28, 2-33, 3-8, 3-10, 3-11, 3-12, 3-17, 3-19, 3-25
Blend Interval  2-34, 2-38, 2-40, 3-19, 3-30

Color  2-28, 3-8, 3-10, 3-25, 3-26, 3-28, 3-29, 3-30, 3-31
Not Color  2-28, 3-11, 3-25, 3-30, 3-31

Blend Slider
Key Color  2-27, 2-36, 2-41, 3-8, 3-12, 3-17, 3-21, 3-22
Not Key Color  2-30, 2-36, 2-41, 3-23, 3-24
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NuVista+

INDEX

Interval Timer Box  2-29, 2-35, 2-40, 3-27, 3-28, 3-29, 3-30, 3-31
previewing  3-29, 3-31
removing  3-31

NuVista+ Calibration Kit  A-4
NuVista+ Capture  1-3, 1-18, 2-5, 2-16, 4-1, 4-6

Alpha menu
32-bit Alpha Blend  2-17, 4-29
Choose Key Color...  2-12, 4-4, 4-5, 4-19
Clear Alpha Channel  4-28
Interlace  2-17, 4-28
Save Alpha Channel  4-27

Edit menu
Copy  4-11
Undo  4-20

File menu
Capture Image  2-6, 2-7, 4-2, 4-22
Open...  2-18, 4-15



Page I-7

NuVista+

INDEX

Page Setup...  4-16
Print...  4-16
Quit  4-17
Save...  2-14, 4-12, 4-13, 4-27

Special menu
Convert to 8-bit Image  4-10
Convert to 16-bit Image  4-9
Convert to 32-bit Image  2-8, 2-17, 4-8, 4-18, 4-29
Fit Image to Window  2-12, 4-4, 4-5
Fit Window to Screen  2-12, 4-5
Preferences...  2-6, 4-21
Use Dithering  4-3

with two or more NuVista+ cards  4-30
NuVista+ Chroma Keyer  1-18, 2-45, 3-38, 3-39, 3-43

Chroma Key radio button  3-40
Gain radio buttons  3-40, 3-41
Normal Display radio button  3-40
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NuVista+

INDEX

Remove Excess Blue  3-40
removing  3-43
Show Alpha radio button  2-45, 3-40, 3-41, 3-43
with two or more NuVista+ cards  3-44

NuVista+ CloseUp  1-18, 2-3, 3-1
disabling  3-
removing  3-6
with two or more NuVista+ cards  3-6

NuVista+ Installation Guide  2-1, 2-2, 2-23
NuVista+ MasterKeys  1-18, 2-37, 3-7

AlphaBlend  2-20, 2-22, 3-11, 3-12
Color Interval  2-37, 2-38, 2-39, 3-10, 3-11, 3-25, 3-29, 3-30, 3-31
customizing  3-13
disabling  3-14
Home Cursor  3-10
Interlace  2-20, 2-22, 2-32, 2-39, 3-8, 3-9, 3-30, 3-43, 4-28, A-2
Not Color Interval  2-31, 2-38, 2-39, 3-11, 3-25, 3-30, 4-31
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NuVista+

INDEX

Overlay  3-8, 3-9, 3-22, 3-30, 4-29
removing  3-15
Restore Display  3-9
with two or more NuVista+ cards  3-16

NuVista+ SetUp  B-1, B-3
File menu

Open...  B-3
NuVista+ TuneUp  A-4
NuVista+ Video In  2-7, 3-17, 4-1, A-2
NuVista+ Video Out  2-7, 2-23, C-2, C-6
NuVista+ VIDI/O  1-18, 2-4, 2-7, 2-20, 2-23, 2-45, 3-17, 3-18, 3-30, 3-43, 4-1, A-3

Decoder Options  3-35, 3-36
Encoder Options  3-36
Input Selector  3-33
removing  3-37
with two or more NuVista+ cards  3-37
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NuVista+

INDEX

O, P
output cable  1-13
overlay  2-15, 2-16, 3-7, 3-17, 3-22, 4-26, 4-29
pan  2-11, 3-1, 3-3, 3-4
PICT file  1-1, 2-9, 4-1, 4-13, 4-14, 4-18

R
Resolution

Display Color  4-6, 4-11
Image Color  4-21
Monitor Color  4-6
Saved Color  4-7
Screen  4-21, A-7

RGB  1-1, 1-2, 2-4, 2-45, 3-17, 3-18, 3-33, 3-34, 3-43, 4-1

S
S-Video  1-1, 1-2, 2-4, 2-45, 3-17, 3-18, 3-33, 3-34, 3-43, 4-1
S-Video switch  1-8
subcarrier source  3-18, 3-34, 3-37, C-2, C-6
System Folder  1-18, 1-19, 3-6, 3-31, 3-43
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INDEX

T
TGA file  1-1, 4-1, 4-13, 4-14, 4-18
Trouble?  1-4, 2-7, 2-12, 2-17, 2-20, 3-18, 3-30

U, V
Ultimatte Blue  2-43
VCR  1-1, 2-2, 2-4, 2-5, 2-6, 2-23, 2-30, 2-32, 2-38, 2-39, 3-17, 3-33, 4-1, A-2, C-1
video configurations  1-4, C-1
Video In  1-16
Video Out  1-14

Z
Zoom In  1-1, 2-9, 2-10, 3-2, 3-4, 3-5
Zoom Out  1-1, 2-9, 2-10, 3-2, 3-4, 3-5
Zoom Toggle  2-10, 3-3, 3-4, 3-5


